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CSI 2600 Machinery Health Expert
Topics covered in this chapter:
•
•
•
•

1.1

CSI 2600 overview
User Guide overview
User Guide conventions
Technical support

CSI 2600 overview
The CSI 2600 Machinery Health™ Expert is a portable, online analyzer that simultaneously
and continuously monitors and records up to 24 vibration or process channels and up to 4
speed inputs.
The CSI 2600 is available with one or two 6510 signal input modules. Each 6510 module
has 12 analog channels, 2 tachometer channels, and 2 relay channels. Emerson sells the
CSI 2600 as a 12/2/2 channel or a 24/4/4 channel analyzer.
The CSI 2600 comes in non-Transient and Transient configurations. A non-Transient unit is
designated by an "M", such as A2600M, and a Transient unit is designated by "T", such as
A2600T. The analog channel count is also part of the name; a 12 channel unit is designated
by the number "7", and a 24 channel unit is designated by the number "8". Available models
are:
•

A2600M7—non-Transient, 12 channel

•

A2600M8—non-Transient, 24 channel

•

A2600T7—Transient, 12 channel

•

A2600T8—Transient, 24 channel

This manual will assume that the CSI 2600 is an A2600T8—a Transient, 24 channel system.
Use Emerson's AMS Suite: Machinery Health™ Manager software to view orbits, shaft
center lines, Bode, polar, cascade, waveform, and spectrum plots live and simultaneously,
or to archive for future reference.

1.2

User Guide overview
The CSI 2600 Machinery Health Expert User Guide is written for Vibration Analysts,
Reliability Data Collection Technicians, and Reliability Engineers who monitor rotating
machines in a process plant environment. This user guide describes how to set up the unit,
collect data, and transfer the data to AMS Machinery Manager for storage and analysis.
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1.3

User Guide conventions
The following conventions are used throughout this User Guide.
Note
A note paragraph contains special comments or instructions.

CAUTION!
A caution paragraph alerts you to actions that may have a major impact on the equipment or
stored data.

WARNING!
A warning paragraph alerts you to actions that may have extremely serious consequences for
equipment and/or personnel.

1.4

Technical support
When you contact Technical Support, be ready with a screen capture of the error message
and details such as when and how the error occurred.
Hardware Technical Help
Have the number of the current version of your firmware ready when you call.
Software Technical Help
Provide the software version numbers of both your Microsoft® Windows operating system
and AMS Suite: Machinery Health Manager, and your AMS Machinery Manager serial
number. To find AMS Machinery Manager version and serial numbers, select Help > About.
Be at your computer when you call. We can serve you better when we can work through
the problem together.
Software Technical Support
Emerson provides technical support through the following for those with an active support
agreement:
•

Telephone assistance and communication via the Internet.

•

Mass updates that are released during that time.

•

Interim updates upon request. Please contact Emerson Technical Support for more
information.

Contact us
For Emerson Technical Support and Customer Service Toll Free numbers, email addresses,
and hours of operation, please visit http://www.sureservice.com and select Technical
Support and Customer Service.
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Introduction to the CSI 2600
Topics covered in this chapter:
•
•
•
•
•

2.1

CSI 2600 out of the box
Optional services
CSI 2600 monitoring requirements
Precautions
Safety notes

CSI 2600 out of the box
Figure 2-1: CSI 2600 front view
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Figure 2-2: CSI 2600 back view

4
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Figure 2-3: CSI 2600 accessories

•
•
•
•
•
•
•
•

CSI 4500/6500/2600 Machinery Health Monitor firmware DVD
AMS Suite Operating Manuals & Extras DVD
1 Ethernet cable
1 serial cable
1 package of replacement filters
1 standard IEC 320 C13 to NEMA 5-15P power cord
1 3-pin screw mount connector plug
3-piece international AC adapter kit

Optional accessories
•

MHM-97453, Rev 1
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•

Mounting pads

•

BNC connectors

•

Extension cords

Optional firmware
•

PeakVue

•

Modbus

Optional software
•

2.2

2.3

Object Linking and Embedding for Process Control (OPC)

Optional services
•

Training in the Online Prediction Operation and Maintenance course and rolling
element bearing vibration.

•

Remote analysis.

•

Turbomachinery diagnostic training and AMS Machinery Manager transient analysis
training.

CSI 2600 monitoring requirements
The CSI 2600 portable transient monitoring requires:

2.4

•

Field wiring to installed sensors

•

AC line power wiring

•

Connection points (usually a buffered output panel) for cabling to the CSI 2600
monitoring unit

•

Computer

•

CSI 2600 firmware (loaded on Online Server, downloaded into CSI 2600 monitoring
unit)

•

Machinery Health Manager online software

•

Online Database

•

Ethernet cable

Precautions
Cleaning
The CSI 2600 is dust resistant. Use a damp, clean cloth for cleaning. Do not use cleaning
fluids, abrasives, or aerosols, as they could enter the device, causing damage, fire or
electrical shock.

6
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Avoid water
Avoid direct contact with water, wet surfaces, or condensing humidity. Keep away from
wet locations such as sinks, laundry, wet basements, swimming pools, and so on. If the
device is subjected to these conditions, adverse operation may result. If the surface of the
device becomes wet, allow it to dry thoroughly before operation.
Avoid damage or injury
Follow these guidelines to avoid costly damage or injury:

2.5

•

Place the device on a solid, stable surface when not in use and do not place any
heavy objects on it.

•

Use only accessories recommended by Emerson Process Management.

•

Keep liquids and foreign objects away from your CSI 2600.

•

Never operate your CSI 2600 if any liquid or foreign object has entered it.

•

The enclosure should never be subjected to direct sunlight for long periods of time.

Safety notes
This document is intended as a guide only. No instructions given here are intended to
supersede any locally issued directions or safety instructions.

WARNING!
Do not operate the CSI 2600 in a hazardous area.
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Getting started
Topics covered in this chapter:
•
•
•
•
•
•
•
•
•
•
•

3.1

Remove the CSI 2600 from the case
Turn on the CSI 2600
Turn off the CSI 2600
CSI 2600 fuse access
Data collection overview
Data recorder modes
Store data on a NAS hard drive
Network configuration
System architecture
Access the termination board
Connectivity

Remove the CSI 2600 from the case
CAUTION!
The CSI 2600 should be placed on a dry, level, cool surface where the vents and fans are not
blocked. Avoid hot, wet surfaces and do not block the vents or fans.
Note
The CSI 2600 cannot be used while in the case.

Procedure
Reach down along the top and bottom of the CSI 2600 and extract the device straight up
from its case.
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Figure 3-1: Remove the CSI 2600 from the case

3.2

Turn on the CSI 2600
The CSI 2600 has two toggle switches, and both must be toggled in order to turn the unit
on and off.
Prerequisites

WARNING!
Ensure that physical contact with unbuffered sensor signals will not interfere with other
monitoring or protection systems.

Procedure
1.

Plug the power cord into a standard 120 - 240 VAC input. Attach one of the provided
adapters if necessary.
The unit automatically senses the correct voltage.

10

2.

Press the toggle switch located at the rear of the case to On.

3.

Press the toggle switch located at the front of the case to On.
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3.3

Turn off the CSI 2600
Prerequisites
Make sure that the computer has been connected long enough to allow all of the desired
data to be transferred to the computer for storage. Check the time stamps of the data
being reported in Online Watch. Once the times have progressed past the time range
needed, data collection can be stopped and the CSI 2600 can be powered off.
Procedure
1.

Turn the toggle switch located on the front of the unit to the Off position.
After a couple seconds, the light will turn off. Wait for the light to turn off before
continuing with the next step.

3.4

2.

Turn the toggle switch located on the back of the unit to the Off position.

3.

Unplug the power cord.

CSI 2600 fuse access
CAUTION!
Turn off the power to the CSI 2600 and unplug the unit before accessing the fuses.

Two 10 A fuses for the power input are accessible through a small access panel between
the receptacle and the power switch. The access panel can be opened with a flathead
screwdriver.
Figure 3-2: Fuse access
The AC power input is located on the unit's faceplate.

A.
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3.5

Data collection overview
The CSI 2600 is a continuously monitoring online system. Once configured, it will collect
both periodic predictive data (Trend, Spectra, and Waveform snapshots, multiplexed two
channels at a time) and Transient measurements (continuous unbroken waveforms for
extended periods on up to all 24 channels). Predictive data can be stored in an AMS
Machinery Manager database. Sections of the transient waveforms can also be extracted
into archives either on-demand or based on alarm events.
For the Transient channels, the CSI 2600 continuously stores waveform measurements on
a Hard Disk Drive (HDD). This can be either the internal 80 GB HDD or an external NAS
drive (up to 250 GB). When the drive fills up, the system will begin overwriting the oldest
measurements in a First In First Out (FIFO) manner.
Data is stored at a rate of approximately 40 MB per hour per channel. The following
method can be used for estimating the amount of time that data can be streamed to the
HDD before it begins to FIFO. First determine the number of channels that will be
commissioned for Transient operation; then use this equation:
Storage Time (in hours) = HDD size / (number of Transient channels x 40 MB/hr).

For example, consider a pump monitoring system which has a total of 14 sensors. This
could include 4 pairs of radial shaft vibration probes, 2 thrust probes, 1 case expansion
sensor, 1 eccentricity sensor, and 2 horizontal accelerometers. In addition to collecting
periodic prediction data, the 8 shaft vibration probes are also commissioned for Transient
data collection.
80,000 MB / (8 channels x 40 MB/hr) = 250 hours (approximately 10 days)

So, the internal HDD will store data for approximately ten days before starting to FIFO.
The CSI 2600 is both a continuous monitoring system and a portable monitoring system. It
can be moved from one piece of equipment to another, with data from each piece stored
in separate databases. See Section 6.10 for more information.

CAUTION!
Changing databases will reinitialize the Transient HDD, which eliminates all stored data.
Extract any data before changing databases.

3.6

Data recorder modes
Data collection to CSI 2600 internal memory
When the CSI 2600 is running and the computer is disconnected, the unit runs in DAT
recorder mode, optimized for turbomachinery transient data. Waveforms from up to 24
channels, including tach striping, are recorded continuously and simultaneously. If all 24
channels are streaming transient data, the internal 80 GB HDD will store approximately 90
hours of data before it begins to FIFO.

12
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With the computer disconnected, the periodic predictive data is also buffered in the CSI
2600’s internal RAM. The amount of time it will take to fill up the CSI 2600’s internal RAM
depends on how periodic predictive data storage settings are configured in the database.
This data will also begin to FIFO when the memory buffer is full.
Data extraction from the CSI 2600
If the computer is reconnected while the CSI 2600 is in DAT recorder mode, any buffered
periodic predictive data that has not been deleted by the FIFO process will automatically
be transferred from internal memory to the database. Transient data will only be written to
the database if a transient alarm event has occurred and the associated data has not been
deleted by the FIFO process. Each transient channel can transfer a configurable amount of
data (up to 30 minutes before and after) when a predefined transient alarm event has
occurred.
When the computer is reconnected, portions of recorded data can be extracted on
demand with AMS Machinery Manager Vibration Analysis. Field-based processing of
multiplexed predictive data continues as usual while Vibration Analysis extracts data.

CAUTION!
If the computer is not connected, data may be lost or overwritten.

3.7

Store data on a NAS hard drive
The default streaming location is the internal hard drive. However, an external NAS drive
can be used as an alternative transient streaming location. The CSI 2600 supports NAS
drives up to 250 GB in size. You can use a NAS hard drive as the primary drive for transient
storage or as a failover drive.
Prerequisites
Connect the NAS drive to the same port that is used to connect to the computer. The NAS
drive must be capable of continuous write speeds of >20 MB/s, 100 Base-T minimum, and
rated for a 100% duty cycle.
Procedure

MHM-97453, Rev 1

1.

In the AMS Machinery Manager Online Configuration tree structure, click one of the
units to display the Unit Properties dialog.

2.

Configure values in the External Network Folder Specifications field.
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Figure 3-3: Online Configuration—External Network Folder Specifications

Table 3-1: External Network Folder Specifications dialog fields
Field

Values

Explanation

UNC Path

(variable)

Specifies the to the NAS drive folder where the unit
should stream transient data.

Allowed Drive Space

1–250 GB

Specifies the limit for transient data on the NAS
drive. The data will begin to FIFO when it reaches
this limit.

Use Drive Space As

Primary

Indicates that the NAS drive is to be used as the
primary streaming location (replacing the internal
hard drive.

Failover

Indicates that the NAS drive is to be used as a failsafe location in the event that the internal hard
drive fails.

Username and Password

Specifies the username and password that will
access the NAS drive folder named in UNC Path.

Credentials

Example: Storage
If a 250 GB NAS drive is storing data from 24 transient channels, then it can store
approximately 260 hours of data before it begins to overwrite the oldest measurements. If
only 12 channels are streaming data, about 520 hours can be stored.

3.8

Network configuration
IP addresses are unique addresses that systems on a network use to communicate with
each other.

14
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Table 3-2: Example CSI 2600 system IP addresses
CSI 2600 Main Processor IP

192.168.0.10

CSI 2600 Transient Processor IP

192.168.0.11

Computer IP

192.168.0.1

Notes
•

The IP addresses shown are defaults. If two or more systems will be used, each should be
given a unique IP address.

•

IP addresses should be given subnet masks. Transient extraction may fail without them. See
Section 5.7.6 for information on specifying subnet masks.

The computer's Ethernet port is connected to the CSI 2600. The port has an address. The
CSI 2600 has two processing boards, both of which communicate using the same physical
Ethernet connection on the CSI 2600 front panel. These boards have IP addresses that are
stored in non-volatile memory (memory that does not get cleared when you turn the unit
off). For a CSI 2600 system to communicate:
•

the IP address of the computer must match a value stored in non-volatile memory in
each CSI 2600 processing board.

•

the IP address of the CSI 2600 Main Processor board must match a value listed in
AMS Machinery Manager software, which is associated with the database in use.

In short, the CSI 2600 must “know” its server address, and the computer must “know” the
IP address of any CSI 2600.

3.9

System architecture

3.9.1

CSI 2600 online database diagram
The structure of an online database is designed to mirror the structure of the equipment
being monitored. The database structure for prediction processing diagram shows the
relationships of the various elements of an online database.

MHM-97453, Rev 1
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Figure 3-4: Online database diagram

Collection criteria
•

16

Analysis Parameter (AP) Set—Defines a particular way to collect spectral data, and
specifies:
-

the number of lines of resolution.

-

any averaging modes and windowing.

-

whether to be order-based.

-

what FMax to use.

-

what parameters are to be collected.

•

Alarm Limits (AL) Set—Each AL Set is associated with a specific AP Set. There may be
multiple AL Sets defined for any given AP Set to accommodate changing monitoring
conditions. The alarm limit definition determines when alarms occur, data is stored,
and output relays are set.

•

Predicate—A collection predicate is an expression that compares the conditions of
vibration levels, input relay states, and/or machine speeds to determine when data
is collected and transient auto-archives are extracted.
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Online storage logical hierarchy
•

Area—A user-defined grouping of equipment. An area often corresponds to a
building or section of a process line within a plant.

•

Equipment—A group of coupled devices that logically should be monitored
together. Most often a machine train is made up of a driver component (such as a
motor) and one or more driven components (such as a pump or fan).

•

Components—A specific, single asset to be monitored, possibly with multiple
sensors. Usually a driver or driven piece of machinery. Motors, engines, turbines,
pumps, and fans are examples of components.

•

Measurement Points—Corresponds to a single physical sensor. A Measurement Point
groups together all the data from all the collections that have been defined for a
particular sensor. Any Gross Scan data collected on the sensor and reported for
storage is logically associated with the Measurement Point in the database.

•

Data Collection Sets (DCS)—The DCS is a single collection of data on a single
Measurement Point. Multiple DCSs allow multiple collections on a single
Measurement Point. The DCS combines a particular predicate (when to collect),
with a particular AP Set (what and how to collect, including parameter bands), and a
specific AL Set (alarm set points).

Physical hierarchy
•

CSI 2600—The physical monitoring unit.

•

Signal Channels—An AC vibration or DC process input.

•

Tachometer Channels—A speed measurement input.

•

Digital I/O Channels—A discrete relay, Input or Output.

CSI 2600 field wiring
In addition to predictive monitoring, the CSI 2600 is also a portable transient monitoring
system, which means in most applications it is being connected to already installed
sensors. Portable transient monitoring is different from a fixed, permanently connected
system. For example:

MHM-97453, Rev 1

•

The portable application includes actions of connecting and disconnecting cables
between the CSI 2600 monitoring unit and installed modules or even junction
boxes. It is critical to ensure that these actions do not interfere with signals in such a
manner that any permanently installed monitoring systems interpret temporary
signal fluctuations as trip conditions. This is not a concern when connecting to
module buffered outputs.

•

Modules may condition the input signal and present a modified version to their own
output connections (which are the input connections to the CSI 2600). For instance,
some modules connect to an eddy current sensor which provides a DC output
equivalent to gap voltage (usually about -10 V) and an AC voltage equivalent to
vibration (millivolt signal). These modules are configured or programmed to provide
a version of the input signal, at an output connection. The output signal could be a
0 – 10 V version of the input.

17
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An analyst must know the sensitivity and offset of signals connected to the CSI 2600,
which may be the same (or different) as signals connected to existing modules. An analyst
must also know if the CSI 2600 connections are to buffered or unbuffered field wiring or
module outputs.

3.10

Access the termination board
1.

At the bottom of the rear panel, loosen the thumbscrews by hand.

WARNING!
Close the rear panel before powering the CSI 2600.

2.

To lock the rear panel in the open position, lift the panel to an almost horizontal
position and gently push down near the top center of the panel (as shown).
Figure 3-5: Termination board

3.

Toggle the DIP switch to the left to turn off sensor power, or to the right to turn it
on.
The set of four DIP switches on SW1 controls sensor power for channels 1–4. Sensor
power for the subsequent channels is controlled by the DIP switches on SW2, SW3,
SW5, SW6, and SW7.

18
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3.11

Connectivity
The CSI 2600 monitoring unit consists of:

3.11.1

•

An AC power connection (110–220 V, 50/60 Hz)

•

An Ethernet connection

•

Signal connections for 1–24 sensors

•

Tachometer connections for 1–4 sensors

•

Digital I/O relay connections for 1–4 relays

•

System power status LEDs

•

An attached cooling fan

Power supply
Power input: 120–240 VAC, 50–60 Hz input, auto-sensing.
•

AC power connection has an IEC 320 C13 receptacle

•

North American 3-prong plug (NEMA 5-15P) is provided

•

Unit may be powered with either 110 V / 60 Hz or 220 V / 50 Hz input power

•

No internal switches need to be adjusted to select power type

•

80 W consumption

Note
A 500 W UPS is recommended. The quality of the power provided to the CSI 2600 is very important.
Although the CSI 2600 contains input protection and some degree of line conditioning, it is
important to provide the unit with clean power when ground isolated from the production
equipment.

3.11.2

Ethernet ports
Use the NIC port to connect the CSI 2600 to the LAN.
Use the Hub port to connect the CSI 2600 directly to the computer.

MHM-97453, Rev 1
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Figure 3-6: Ethernet ports
The NIC and Hub ports are located on the unit's faceplate.

3.11.3

Channel connections
The CSI 2600 offers up to 24 sensor channels. The connections are made through the BNC
connectors on the rear of the CSI 2600.
In addition, the CSI 2600 offers up to 4 tach channel connections, up to 4 digital relay
channel connections, and 1 Ethernet HUB and 1 NIC.
The CSI 2600 can accept any sensor type with AC component 10V pk-pk and DC
component < +/-24 V, AC+DC not to exceed +/-24 V. Accelerometers can be powered by
the CSI 2600 system’s power supply when sensor power is enabled via the DIP switches on
the termination panel, accessible through the rear panel. Displacement probes can be
powered by the auxiliary -24 VDC power supply. The output for this -24 VDC power supply
is on the rear of the CSI 2600.
Tachometers should provide 1/rev pulses of >0.5V pk-pk with tach pulse 2x noise.

WARNING!
Make sure that the sensor power is disabled when connecting to a protection system with
unbuffered BNC outputs.

3.11.4

4-channel relay inputs and outputs
The CSI 2600 includes up to 4 I/O relay connections that provide optically isolated digital
inputs or dry contact outputs. Inputs can be between 5 V and 24 VDC. Outputs are limited
to 24 VDC @ 0.5 A.
The 6510 Signal Input module is a component that connects to the unit's faceplate, and
allows a combination of sensor and relay types in one module. Each I/O relay channel on
the 6510 Signal Input module contains both input and output hardware. The relays are
configurable as either input or output relays, with a DIP switch (SW1) on the circuit board.
A relay channel that is configured in software cannot be utilized unless the corresponding
DIP switch is set to the correct position. The firmware will detect the DIP switch state at
startup and generates a flag in the HyperTerminal(1) session if the software configuration
does not match the DIP switch setting.

(1) See Section 5.7 for more information on terminal emulators like Hyper Terminal.
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The DIP switches are used to protect a user input device from inadvertently being shorted
by a relay output configuration. Set the corresponding DIP switch to the On position for
output relays, and to the Off position for input relays. The factory default state of the DIP
switches is Off (Input). DIP switch 1 is for the first relay channel and DIP switch 2 is for the
second relay channel.
The shelf-state of the output relays is normally open, meaning that when the power to the
unit is disconnected, the relays are open. During operation of the unit, the relays are
typically closed until activated by an alarm, but they can be configured either way.
The following are usage examples for an online monitoring system:
•

(input) Transient event indicator, perhaps from a switch, DCS, external module

•

(output) Bad/failed sensor indication

•

(output) Alarm level indication

•

(output) Speed level indication

•

(output) Radial Trip Predicate state

•

(output) Axial Thrust Predicate state

In most applications, the CSI 2600 will connect to buffered outputs of a protection system.
These modules normally have relay outputs which indicate alarm levels, or bad/failed
sensors. However, the CSI 2600 relays are different in that:
•

A CSI 2600 alarm relay state may be based upon either overall vibration value (i.e.,
the attached module) or Analysis parameter signal level (i.e., energy at 1x turning
speed, energy at 2x turning speed).

•

All, some, or one of the alarm indicators may be mapped to the same CSI 2600
alarm relay output. In other words, all of the “Bad/Failed sensor” signal levels may be
internally connected to a single relay. All of the “High alarm” signal levels may be
internally connected to a single relay.

Radial Trip and Axial Thrust predicates are special methods of configuring voting logic for
relay closures, and are explained in Emerson Machinery Health Manager manuals such as
the Online Software guide (MHM-97460). These are innovations provided by the CSI 2600
system, which have value in turbo machinery applications.
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Hardware configuration: overview
Topics covered in this chapter:
•
•
•
•
•
•
•
•
•
•
•

Gross Scan monitoring
Spectral Scan
Transient data capture
Install a module
Remove a module
6560 Processor module
CSI 2600 signal inputs
6510 Signal Input module
Mounting accelerometers
Mounting tachometers
Eddy current sensors

The 6560 Processor Module, in combination with the 6510 Signal Input Module, is a multichannel, multi-tasking, multi-processor data acquisition system primarily intended for
monitoring heavy industrial rotating machinery. Typical signal inputs are dynamic AC
machine vibration signatures from accelerometers, velocity probes, or eddy current
sensors. These signals include two components: the dynamic AC component, which
represents machine vibration, and a DC component, which represents the sensor bias
level. In the case of an eddy current sensor, the DC component represents the gap, or
average distance between the probe tip and the machine shaft. Other signal inputs include
process signals; these are DC parameters such as temperature or pressure.
Tachometer inputs are used to determine machine speed. These tachometer signals are
typically generated from an eddy current sensor or passive magnetic sensor positioned at
a machine shaft keyway or gear, producing a pulse train (not necessarily 1x machine
speed) representing the machine phase and running speed.
Discrete inputs represent machine states such as running, off, and starting. These inputs
are used to control or modify the data acquisition based on machine state. Common state
control inputs are relay closures or machine RPM. AC or DC signal levels can also be used
for state control.

4.1

Gross Scan monitoring
Gross Scan monitoring includes:
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•

the acquisition of the overall level of the dynamic AC vibration signal, typically the
RMS value of the signal.

•

the DC sensor bias level.

•

the measurement of a DC process signal.
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All these signal inputs are DC values (the RMS value is a DC value proportional to the
overall energy content of the AC signal). The Gross Scan inputs are multiplexed into a fast
successive approximation ADC controlled by the 6560 Processor module. Gross Scan
monitoring measures all input channels AC+DC twice per second. When the Transient
option is included, true waveform peak-to-peak may be included in Gross Scan
monitoring.

4.2

Spectral Scan
Spectral Scan is defined as the acquisition and analysis of dynamic AC signals only. The
signals are acquired, two channels at a time (referred to as CHX and CHY), with a dual
channel delta-sigma ADC controlled by the system DSP. The DSP performs analysis of the
acquired time waveforms and transmits the results to the CPU host processor.
Preprogrammed groups of Spectral Scan measurement parameters (AP Sets) may be
assigned to specific machine state conditions to tailor data acquisition to specific machine
operational states.

4.3

Transient data capture
Transient data capture is the acquisition of continuous time waveforms of dynamic AC
signals. Transient data is captured in parallel for all channels. Other data stored along with
the Transient data include Gross Scan data captured once per second, tach pulse records,
and acquisition timestamps. The Transient data is stored on hard disk, and is available for
real-time analysis via Ethernet.

4.4

4.5
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Install a module
1.

Line up the guide rails and push the module into the slot until fully seated.

2.

Tighten the mounting screws.

Remove a module
1.

Loosen the mounting screws.

2.

Push outward on the handles to eject the module from the backplane connectors.

3.

Pull the module from the slot by the handle.
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Figure 4-1: Remove a module
Use the handles to remove modules.

4.6

6560 Processor module
The 6560 Processor module provides all data acquisition, data storage, and data
communications functions for the CSI 2600. The 6560 is capable of up to 24 simultaneous,
continuous waveform measurements for detailed Spectral analysis, up to 24 RMS and DC
values for Gross Scan measurements, up to 4 tachometers for machine speed
measurement, and up to 4 discrete state inputs.
Gross Scan values, tachometer values, and digital input states may be combined logically
to determine machine operating state, which may be used to define specific data
acquisition states. The system can be configured to transmit and store data on either time
interval or based on the amount of change of the data values.
The processor module provides 2 100Base-T Ethernet ports and one RS-232 serial port for
system communications and diagnostics. Additional connections are available for the
calibration signal and a dry contact SPDT SysFail relay. This relay is energized when the
Processor CPU successfully boots. On a CPU failure or power loss, the relay will deenergize.

MHM-97453, Rev 1

25

Hardware configuration: overview

Figure 4-2: 6560 Processor module

4.6.1

Transient Daughterboard
The Transient Daughterboard adds the capability for parallel, continuous time waveform
acquisition on all channels. All collected time waveform data, along with Gross Scan data
and up to four tachometer pulse records is stored on an internal hard drive, which provides
approximately 80 minutes per GB of storage.
The Transient Daughterboard can also stream data via Ethernet to analysis applications in
near real time, without affecting data collection or on-board data storage.
While collecting time waveforms and tachometer pulses, the Transient Daughterboard
continuously calculates the peak-to-peak value of each channel's waveform. When
configured, this value may be sent to the 6560 Processor module for use as the Gross Scan
instead of the RMS value produced by the 6510 Signal Input module.
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The hard drive used on the Transient Daughterboard is specially rated for continuous
operation. This drive should be replaced annually. In emergencies, any 2.5 in. parallel IDE
drive may be used temporarily, but these drives are not generally rated for continuous
operation.
When installing the Transient Daughterboard on the 6560 Processor module, make sure all
five mating connectors are fully engaged, and then install all six mounting screws.
Figure 4-3: Transient Daughterboard PCB mounted on Processor module

A.
B.

Mounting screw positions
Transient Daughterboard hard drive

Replace the Transient Daughterboard hard drive
Figure 4-4: Transient Daughterboard hard drive inset

A.
B.
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Hard drive mounting screws
Ribbon cable
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Procedure
1.

Remove the four hard drive mounting screws.

2.

Gently remove the hard drive ribbon cable from the hard drive, and then remove the
old hard drive.

3.

Install the new hard drive in the bracket.

CAUTION!
Do not over tighten the screws.

4.

Replace the ribbon cable. Take care to line it up correctly.

Format the hard drive for the Transient Daughterboard
Before the new hard drive can be used, it must first be formatted by the Transient
Daughterboard.
Prerequisites
•

Power on the system.

•

Ignore any hard drive error messages produced by the Transient Daughterboard on
the HyperTerminal monitor.

•

When the system has booted, use the DHM_III program (located in the C:\inetpub
\ftproot\bin\Tools directory) to format the hard drive.

Procedure
1.

Launch DHM_III.exe.

2.

Select the Transient menu.

3.

Click Format Hard Drive.

Postrequisites
When the drive has been formatted, reboot the unit. Ignore any hard drive error messages
produced by the Transient Daughterboard on the HyperTerminal monitor.
When the POST process is complete, the firmware will automatically prepare the hard
drive with the Transient File System. This process may take up to an hour.
Reboot the unit. The boot process should now complete normally with no hard drive error
messages. If configured, Transient data collection should begin, indicated by a flashing
hard drive indicator on the Processor front panel.

4.7

CSI 2600 signal inputs
The CSI 2600 is designed to receive voltage signals directly from sensors or from sensor
support modules. The online database will store the collected sensor signal in the
appropriate engineering unit, such as acceleration, velocity, displacement, and pressure.
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Signals from 4-20 mA devices, RTDs, thermocouples, and other specialized sensors require
external conditioning electronics that convert the sensor signal into a voltage signal the
CSI 2600 can accept on its BNC input panel. The CSI 2600 can supply power to
piezoelectric sensors from the BNC connection.
The CSI 2600 has 4 BNCs for tachometer inputs on the rear panel. The tachometer BNC
inputs accept voltage signals only and do not furnish tachometer power.
When the CSI 2600 is in transient data collection mode, not all signals connected to a CSI
2600 need to be designated as transient. But since the Transient system is used to detect
unexpected events using its continuous monitoring capability, it's best to designate every
channel to be transient to make sure a special event is not missed.

4.8

6510 Signal Input module
The 6510 Signal Input module combines the features of Signal Input, Tachometer Input,
and I/O Relays to allow a combination of sensor and relay types in one module.
The 6510 provides 12 channels of vibration or process sensor inputs, 2 channels of
tachometer sensor inputs, and 2 optically-isolated I/O relay channels.
See Section A.2.2 for specific calibration information.
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Figure 4-5: 6510 Signal Input module

4.8.1

Vibration signal inputs
The vibration sensor types include accelerometer, passive velocity, active velocity, and
displacement. The Signal Input module will also accept non-specific AC or DC inputs from
any source that conforms to the input range limits.
The vibration inputs provide the following programmable functions for each channel:
Input Attenuator /1, /2, Gain x1, x10, integrator on/off. In Table 4-1, the combination of
input attenuator and gain setting provide four input range combinations.
Table 4-1: Signal input module input ranges
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Attenuator

Gain

Input Range +/-

/2

x1

10.0 V, 100 g, 100 ips, 50 mil
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Table 4-1: Signal input module input ranges (continued)
Attenuator

Gain

Input Range +/-

/1

x1

5.0 V, 50 g, 50 ips, 25 mil

/2

x10

1.0 V, 10 g, 50 ips, 5 mil

/1

x10

0.5 V, 5 g, 5 ips, 2.5 mil

The integrator allows acceleration signals to be converted to velocity.
The 6510 Signal Input module selects 2 of the 12 vibration channels at a time and routes
them to the Processor module for spectral analysis. RMS-to-DC conversion is performed on
all 12 channels. The RMS and DC signals are routed to the Processor module for Gross Scan
collection.
The Transient Filter Board is required for Transient data acquisition.
To measure 4-20 mA signals, add a resistor across the channel input. A typical value is 250
ohms, which converts 4-20 mA to 1-5 V. Maximum series resistor value is 1000 ohms.

4.8.2

Tachometer inputs
The Tachometer inputs allow measurement of two pulse tachometer sources per module.
Tachometer sensor types may include, but are not limited to: eddy current sensor, Hall
effect sensor, or TTL pulse type from various sources.
The Tachometer Input module features either fixed voltage trigger or “adaptive”
automatic triggering. Triggering parameters may be set independently for each
tachometer sensor input.
An input gain selection of x1 or x5 may be selected for each channel. A gain of x5 is
recommended for tachometer inputs smaller than 1 V pk-pk. If the x5 input gain is used,
care should be taken to make sure that the input signal remains within +/-24 V, including
any sensor bias or gap voltage.

4.8.3

I/O relay channels
Each 6510 Signal Input module has two I/O relay channels that provide optically isolated
discrete inputs or dry contact outputs. Inputs can be between 5 V and 24 VDC. Outputs are
limited to 24 VDC @ 0.5 A.
Note
AC relays are not provided.
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Figure 4-6: Signal Input module PCB

A.

I/O relay DIP switches

Each I/O Relay channel on the 6510 Signal Input module contains both input and output
hardware. The relays are configurable as either input or output relays, with a DIP switch
(SW) on the circuit board. A relay channel that is configured in software cannot be used
unless the corresponding DIP switch is set to the correct position. The firmware will detect
the DIP switch state at startup and generates a flag in the HyperTerminal session if the
software configuration does not match the DIP switch setting. The DIP switches are used
to protect a user input device from inadvertently being shorted by a relay output
configuration.
Set the corresponding DIP switch to the ON position for output relays, and to the OFF
position for input relays. The factory default state of the DIP switches is OFF (Input). DIP
switch 1 is for the first relay channel and DIP switch 2 is for the second relay channel.
The shelf-state of the output relays is normally open, meaning that when the power to the
unit is disconnected, the relays are open. While operating the unit, the relays are typically
closed until activated by an alarm, but they can be configured either way.
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4.8.4

Transient Filter Board
The Transient Filter Board provides parallel anti-aliasing filters for the signal channels on
the Signal Input module. Either one or two Transient Filter Boards may be used to
configure either a 12- or 24-channel Transient System.
When installing the Transient Filter Board on the Signal Input module, make sure both
mating connectors are fully engaged, then install all six mounting screws.
Figure 4-7: Transient Filter Board PCB mounted on a Signal Input module

A.
B.
C.

Mounting screw positions
Transient Filter Board
I/O relay DIP switches

4.9

Mounting accelerometers

4.9.1

Handling accelerometers
General purpose accelerometers are susceptible to mechanical shock. Take precaution
when handling sensors. When magnetically mounting sensors, it is possible to generate
shock loads that will damage sensors and void the manufacturer’s warranty. To prevent
damage, gently rock magnetic sensors into place.

WARNING!
Do not drop, hammer, or impact the sensor housing before, during, or after installation.
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CAUTION!
Do not exceed specified torque when tightening stud-mounted accelerometers. Overtightening accelerometers will damage sensing elements and void the manufacturer’s
warranty.

Although the integral cable has built-in strain relief, avoid excessive pulling force during
cable pulls. Secure cable to the machine near the point of sensor installation.

CAUTION!
Do not exert more than 5 lbs pull force directly on sensor/cable connection during wire pulls.

If sensor mounting occurs before cable is pulled in conduit or raceway to junction box,
leave cable bundled and secured to the machine. Sensor cable cannot be stepped on or
severely kinked, or permanent signal degradation will occur. Cable bundle should also not
be placed in such a manner that it will cause undo strain at the sensor/cable connection.

4.9.2

Tools and supplies
Mounting tools
•

Drill

•

Spot face or end mill tool

The spot face tool attaches to a standard electric drill and provides a machined surface at
least 1.1 times greater than the diameter of the sensor. At the same time, the spot face
tool also drills a pilot hole that can then be tapped for the stud mounted sensor.
The spot face tool can be purchased from Emerson or a spot face tool with similar
characteristics may be substituted as required. Contact your local sales representative for
assistance.
Figure 4-8: Spot face or end mill tool

For epoxy mounting, the following are also necessary:
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•

2-part epoxy (e.g. Loctite Depend [Emerson P/N A92106] or comparable)

•

A212 Mounting Pads
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•

(Optional) Grinder – to create a sufficiently flat mounting surface

Accelerometer attachment tools and supplies
•

40-200 in. lb torque wrench with 1/8 in. hex bit
Suggested vendor: Grainger
Part number: 4JW57
Description: 3/8-in. drive in. lb torque wrench. Any torque wrench with a range of 40
to 70 in. lb and less than 5 in. lb increments can be substituted.

4.9.3

•

1/4 in. 28 taps and tap handle

•

9/16 in. open-end wrench

•

1/8 in. hex Allen key

•

Wire brush

•

Plant-approved cleaner/degreaser

•

Plant-approved semi-permanent thread locker (e.g. Loctite)

Surface preparation: stud mount
Note
The mounting location must provide a flat surface, 1 in. in diameter. If this is not possible, an
alternative mounting procedure must be used. Do not proceed; contact the project manager.
Note
The mounting location must provide a case thickness exceeding 0.4 in. If this is not possible, an
alternative mounting procedure must be used. Do not proceed; contact the project manager.

Stud mount
1.

Prepare the spot face or end mill tool by setting the drill bit depth to a minimum of
0.325 in. (325 mils).

2.

Using a wire brush and plant-approved cleaner, clean and degrease the surface area.

3.

Keeping the spot face/end mill tool perpendicular to the machine surface, drill into
the mounting location until the surface is smooth to the touch with no noticeable
irregularities. This may require the spot face tool to remove as much as 0.04 in. (40
mils) or more from the surface.
Note
If the spot face is not uniform on all sides, this is an indication that the spot face tool is not
perpendicular to the mounting surface and the resulting surface will not allow the sensor to
be mounted properly.

4.

Using 1/4 in.-28 tap set, tap a pilot hole to a minimum depth of 0.25 in. (250 mils).

Refer to Figures Figure 4-9 through Figure 4-11 for illustrations on the stud mount method.
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Figure 4-9: Correct (left) and incorrect (right) milling processes
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Figure 4-10: Milling process for sensor mounting
This spot facing should result in a uniform seat being created.
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Figure 4-11: Tapping a pilot hole

4.9.4

Surface preparation: epoxy mount
Note
The mounting location must provide a flat surface, 1 in. in diameter. If this is not possible, an
alternative mounting procedure must be used. Do not proceed; contact the project manager.

Epoxy mount
1.

If the equipment surface has a radius of curvature that is less than 4 in., grind a flat
surface approximately 1/2 in. diameter.

2.

Using the wire brush and plant-approved cleaner, clean and degrease the surface
area.

3.

Using a 2-part epoxy (such as Emerson P/N A92016), spray the activator onto the
mounting surface.

4.

Place a light coat of epoxy on the surface of the mounting pad (such as Emerson P/N
A212) and hold firmly against the machine spot face surface for 1 minute.
If the adhesive does not set within 1 minute, it is an indication that too much epoxy
is applied or that the mounting surface is not prepared properly. Repeat steps 2
through 4.
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4.9.5

Install mounting studs
For use when installing A911 mounting stud or A0322 Quick-Connect base.
Procedure
1.

Using a plant-approved degreaser, remove any lubricating fluid used during the
tapping process.

2.

Using a plant-approved epoxy, rub a small amount of epoxy onto spot face.

3.

Using a 0.25 in. allen wrench, loosely screw a mounting base into the mounting
location.

4.

Using a torque wrench with a 0.25 in. hex bit, torque to 7-8 ft-lbs.
If the mounting base is not seated against the spot face after torquing, the tap was
not deep enough.

5.

If the sensor will not be mounted immediately, cover exposed quick-connect
threads to prevent contamination. Industrial tape is recommended.

Figure 4-12: A911 Quick-Connect

4.9.6

Mount accelerometers
Prerequisites
Note
If you are not ready to pull cables, do not mount sensors on the machine. If it is necessary to mount a
sensor, the bundled cable must be secured to the machine and protected from damage.

Procedure
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1.

Using a plant-approved cleaner/degreaser, remove any lubricating fluid used during
the tapping process and clean the mounting stud threads.

2.

Rub a small amount of semi-permanent thread locker onto the mounting location.
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3.

Place the sensor onto the mounting stud and hold it to create the least amount of
cable strain and cable exposure. While holding the sensor, hand-tighten the 9/16 in.
captive nut and use a torque wrench with the 9/16 in. open end to finish tightening
to 50–60 in-lbs.

4.

Secure sensor cable to the machine approximately 4–5 in. from the mounting
location using an appropriately sized cable clamp. Do not exceed bending radius of
2.8 in.

Figure 4-13: Sensor installation for industrial swivel mounts
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4.9.7

Mount accelerometers without Quick-Connect
Prerequisites
Note
If you are not ready to pull cables, do not mount sensors on the machine. If it is necessary to mount a
sensor, the bundled cable must be secured to the machine and protected from damage.

Procedure
1.

Using a plant-approved cleaner/degreaser, remove any lubricating fluid used during
the tapping process and clean the mounting stud threads.

2.

Rub a small amount of semi-permanent thread locker onto the mounting location.

3.

Hand-tighten the mounting stud into the sensor housing, and use a 9/16 in. torque
wrench to tighten the sensor and mounting stud into mounting location to 5 ft-lbs.

4.

Secure sensor cable to the machine approximately 4–5 in. from the mounting
location using an appropriately sized cable clamp. Do not exceed bending radius of
2.8 in.

CAUTION!
Mount the sensor to the machine before terminating or securing cable to the machine.

4.10

Mounting tachometers

4.10.1

Handling passive magnetic tachometers
The passive magnetic tachometer is installed near moving machinery—typically a rotating
shaft. Observe clearances between the sensor and the target, and observe cable
clearances.

CAUTION!
The tachometer can be damaged if proper clearance is not maintained between the sensor and
the actuator. Follow installation procedures to set proper clearance.

4.10.2

Tools and supplies
The included mounting bracket and locking nut are required to install passive magnetic
tachometers.
The universal mounting bracket will fit a variety of applications. If the included bracket will
not work, then the contractor will have to fabricate a custom bracket.
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Figure 4-14: Mounting bracket for a passive magnetic tachometer

4.10.3

Actuator choice: guidelines
Actuator dimensions
Some passive magnetic tachometers are designed to be used with a key meeting the
following minimum specifications:
Figure 4-15: Key dimensions

Table 4-2: Key dimensions
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A

Dimension of top of tooth

>0.15 in.

B

Height of tooth

>0.5 in.
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Table 4-2: Key dimensions (continued)
F

Gear thickness

>0.3 in.

If the chosen actuator has a dimension that must be greater than 0.5 in., round the edges
of the actuator to allow the sensor to be as close as possible to actuator.
Figure 4-16: Modifying large actuators

Actuator material
The actuator must be made of a metallic material with a high permeability. Ideal actuators
are soft iron, cold-rolled steel, and #400 stainless steel.

4.10.4
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Mount the sensor bracket
1.

Turn the machinery shaft so that the actuator is at the mounting location.

2.

Place the sensor in the mounting bracket and screw the sensor into the bracket,
exposing an equal amount of thread on the back and front of the mounting bracket.

3.

Place the sensor/bracket assembly into the mounting location and center the sensor
pole piece over the actuator so the pole piece touches the actuator. Mark the hole
locations on the bracket.
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4.

Drill and tap hole locations for an appropriately sized bolt to fit a 0.25 in. opening on
the mounting bracket.

5.

Secure the bracket to the mounting location and torque to bolt specifications.

Figure 4-17: Mounted passive magnetic tachometer

4.10.5

Mount tachometers
1.

Screw the locking nut onto the sensor and thread completely onto the sensor.

2.

Screw the sensor into the mounting bracket until the sensor pole piece contacts the
actuator.

3.

Back off the sensor 1 full turn.

4.

While holding the sensor in place, thread the locking nut against the mounting
bracket. Torque to 15 ft-lbs.

5.

Slowly turn the shaft and confirm that the actuator does not contact the sensor.
If sensor is contacting the shaft, loosen the lock nut and repeat steps 3 and 4.

4.11

6.

Run the machinery at full speed and confirm that the sensor does not contact the
actuator. Let the machine reach normal operating temperature and run through all
operational speeds.

7.

Observe the machinery during coastdown, and confirm that the sensor does not
contact the actuator.

8.

Cover exposed connector threads with the included protective cap to prevent
contamination.

Eddy current sensors
Eddy current sensors are also supported.
Installation instructions for eddy current sensors PR6422–PR6426 and probe drivers
CON011–CON041 are part of the manuals packaged with your sensors.

44

MHM-97453, Rev 1

Software configuration

5

Software configuration
Topics covered in this chapter:
•
•
•
•
•
•
•
•

5.1

System overview diagram
Connect the CSI 2600 to the network server
Configuration overview
Install AMS Machinery Manager
Configure the computer's IP address
Configure the FTP server to download firmware
Configure boot parameters with a terminal emulator
Add an Online Server to RBM Network Administration

System overview diagram
Figure 5-1: System overview diagram
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•

Network Server—Service responsible for handling the user's access to the various
programs within the AMS Machinery Manager software.

•

Online Watch (O_watch)—Graphic interface that allows:
-

viewing of data sent to the server by the CSI 2600

-

management of transient acquisition and auto-extraction
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5.2

-

adjustment of alarm levels

-

on-demand data acquisition

•

Online Configuration (O_config)—Program that allows the creation and modifying
of databases for use with the online system, along with system commissioning.

•

Vibration Analysis (Diagnostics)—Application that allows the user to request and
save transient data and view live streaming data. It provides a variety of analysis
functions necessary for analyzing the data generated by the CSI 2600.

•

CSIMtDbMgr Service—Handles most of the reading and writing operations
performed on databases stored on the server. It also indexes and verifies the
integrity of databases.

•

Online Server (O_server)—The central process service which handles all predictive
activity on the online system. It is responsible for processing requests from the
client, sending configuration information to the CSI 2600, and receiving data from
the CSI 2600.

•

MHM Remote—Service that handles transient data generated by the CSI 2600, and
database access required by the Vibration Analysis program.

•

CSI 2600—Hardware portion of the monitoring system; a portable unit that is
connected to the server through Ethernet.

•

IIS FTP—Microsoft's IIS includes an FTP server which needs to be installed to allow the
CSI 2600 to load firmware from the server.

•

Firmware—The firmware consists of two files which are loaded from the computer
during the boot up of the CSI 2600. This allows most system updates to be installed
on the computer like any other program update without the requirement of any
special interaction with the CSI 2600 beyond rebooting it to allow the new version to
load.

Connect the CSI 2600 to the network server
After configuring the CSI 2600 with an IP address on the same network as the Network
Server, connect to the network server through the Ethernet cable.
Procedure

5.3

1.

If you are using a computer, connect a standard Ethernet cable (included) to
connect the unit's Hub port to the computer.

2.

If you need to connect to a Local Area Network to connect to the network server,
connect a standard Ethernet cable (included) to the unit's NIC port.

Configuration overview
The CSI 2600 is a network-based system. The monitoring unit communicates with a server
through an Ethernet connection. In order for the unit and the server to successfully
communicate, both must have addresses known to each other. The addresses can be
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changed, but AMS Machinery Manager must contain the correct IP address for the CSI
2600, and the CSI 2600 must contain the IP address of the FTP server from which to
download its firmware.
Complete the following steps (each detailed later in this chapter) to configure the
computer you use to connect to the unit:
1.

Install AMS Machinery Manager on the computer.

2.

Configure the computer's IP address.

3.

Configure the FTP server to download firmware.

4.

Configure boot parameters with a terminal emulator.

5.

Add an online server to RBM Network Administration.

Note
If a computer is purchased from Emerson, this configuration is already complete.

5.4

Install AMS Machinery Manager
Install AMS Machinery Manager on your computer with the following options checked:
•

Network Server

•

Online Server

•

AMS Machinery Manager Client

Refer to your software user guide for these details.

5.5

Configure the computer's IP address
Follow your operating system's instructions for changing the computer's IP address.
Procedure
1.

Make a note of your computer's current settings.

2.

Change the IP address assigned to the computer Ethernet port to the address
expected by a CSI 2600.

Table 5-1: Example CSI 2600 system IP addresses

MHM-97453, Rev 1

CSI 2600 Main Processor IP

192.168.0.10

CSI 2600 Transient Processor IP

192.168.0.11

Computer IP

192.168.0.1
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5.6

Configure the FTP server to download
firmware
Firmware is installed in directory C:\Inetpub\ftproot\bin\ in a folder with a name for the product
model: 2600 or 2600T.
Each time a CSI 2600 powers up, it scans its network connection looking for the address
that matches an address stored in internal CSI 2600 memory, and then for firmware at this
directory location. If firmware is found, its version is read and compared to a copy of
firmware stored in internal CSI 2600 memory. If the firmware is the same revision, then the
CSI 2600 boots from its internal copy. If it has a different revision, then the CSI 2600
downloads newer firmware, boots using it, and stores a copy of this newer firmware in
internal memory.
Unless otherwise specified, CSI Machinery Health Monitor systems are pre-configured and
set up during commissioning.
The FTP service must be configured on a computer on the network so that a CSI Machinery
Health Monitor can obtain firmware updates. If an FTP site is not available, the CSI
Machinery Health Monitor boots from the firmware stored in memory. The FTP service is a
Windows Feature that is available but not enabled by default on Microsoft Windows. Refer
to your Microsoft Windows Operating System instructions to enable the FTP Server and set
up an FTP site. These instructions are an overview of the steps to configure an FTP server
for the CSI 6500 on Windows 7 and Windows 2008 R2.
Procedure
1.

Go to Control Panel > Programs > Programs and Features and selectTurn Windows Features on
or off.

2.

Expand Internet Information Services (IIS) and select the following features: FTP Server,
FTP Service, and IIS Management Service.
Microsoft Windows configures the services.

3.

Launch Internet Information Services Manager.
To find the program, go to Start, type IIS in the search box, and select Internet
Information Services (IIS) Manager.
Internet Information Services (IIS) Manager opens.

4.

In the Connections pane, expand the computer node, right-click Sites and select Add
FTP Site.
The Add FTP Site dialog appears.

5.
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Complete the steps in the wizard and configure the settings to match the FTP
settings on the CSI Machinery Health Monitor according to the following example.
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Table 5-2: CSI Machinery Health Monitor FTP configuration
Setting

Description

Site name

The FTP site name to display in IIS Manager. This is for your
reference.

Physical path

The path to the bin directory where the firmware will be installed on
the FTP server (do not include the bin directory). C:\Inetpub\ftproot, for
example.

Binding

Set Binding to All Unassigned or the IP address or a range of IP
addresses assigned to this computer. Do NOT enable virtual host
names.

Start FTP site
automatically

Allow the site to start automatically. Check Start FTP site automatically.

Security

Choose Allow SSL and do not select a certificate.

Authentication

Choose Anonymous if the CSI Machinery Health Monitor's user (u) and
password (pw) boot parameters are set to anonymous.

Authorization

Choose Anonymous users if the CSI Machinery Health Monitor's user (u)
and password (pw) boot parameters are set to anonymous.

Permissions

Read

The FTP site name appears in the Connections pane and the site is started.
Postrequisites
Install the firmware on this computer. You can store the firmware for different hardware
models on the same FTP server.
Table 5-3: CSI Machinery Health Monitor FTP settings

5.6.1

Boot parameter

Definition

Default settings

host inet (h)

The IP address of the FTP server

192.168.0.1

user (u)

The username for the FTP account

anonymous

ftp password (pw)

The password for the FTP user

anonymous

CSI Machinery Health Monitor firmware update
Emerson Process Management periodically releases updates to firmware. When you
update your AMS Machinery Manager software, it is a good practice to update the
firmware if a new version is available. Refer to the Readme file (Readme.rtf) on the
Software Installation DVD for information about the current firmware version. These
instructions apply to the following CSI Machinery Health Monitor systems:
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•

CSI 6500 Machinery Health Monitor

•

CSI 2600 Machinery Health Expert

•

CSI 4500 Machinery Health Monitor

49

Software configuration

Install the firmware on the FTP server
Prerequisites
You need the AMS Machinery Manager Software Installation DVD.
Procedure
1.

Log on to the computer that hosts the FTP Server for your CSI Machinery Health
Monitor.

2.

Insert the AMS Machinery Manager Software Installation DVD.

3.

Open the DVD in Windows Explorer and browse to Install/Online Firmware.

4.

Double-click setup.exe and continue through the installation.
Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

5.

Accept the license agreement.

6.

Select the type of installation.
• Select Typical to install the firmware and tools.
• Select Custom to choose to install either the firmware or the tools.

7.

Follow instructions presented by the installation program.

The online firmware is installed in C:\Inetpub\ftproot\bin\.
Postrequisites
Cycle the power on each CSI Machinery Health Monitor that uses this FTP server.

Reboot the CSI Machinery Health Monitor
Cycle power on the CSI Machinery Health Monitor and verify the system is in good status
after it boots.
Procedure
1.

Cycle the power on each CSI Machinery Health Monitor that needs to get the new
firmware update from the FTP server.

2.

Wait approximately 5 minutes for the system to complete the boot process.

3.

Verify the system is powered on and in good status.
Refer to the Installation Manual for your specific hardware model for more
information.

Check the firmware version in AMS Machinery Manager
1.
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Log on to AMS Machinery Manager Client with the Administrator user account or a
user that has permission to use online technology.
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2.

Go to Tools > Setup/Communications > Online Configuration.
The Online Config window appears.

3.

Go to File > Online Server > Open.
The Select Online Server Host Computer dialog appears.

4.

Choose a server name from the menu and click OK.
The Online Server opens and a tree structure appears in the left pane of the Online
Config window.

5.

In the tree structure, expand Units folder, and right-click the icon next to the CSI
Machinery Health Monitor you want to check and select Properties.
The Unit Properties screen appears in the right pane and displays the State,
Firmware Revision, DSP Revision, Total RAM, and Unit Type.
Figure 5-2: Unit properties

6.

In the Unit Properties pane, verify State is Node(Unit)UP and Firmware Revision matches
the version you installed.
Contact Product Support for help if the firmware version does NOT match.

5.7

Configure boot parameters with a terminal
emulator
During normal usage, it is unlikely that you will need to change the initial boot parameters.
However, two situations may require changes to boot parameters:
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•

The CPU or Transient board is being replaced, and the replacement board has
different boot settings.

•

The CSI 2600 is added to an existing Ethernet network that is not directly connected
to the online server through a dedicated cable.
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Note
Do not add a CSI 2600 to an existing ethernet network until its IP addresses (CPU board,
Transient board) have been verified and changed, if necessary, to be compatible with
addresses already in use on the existing network.

Procedure
1.

Turn on the CSI 2600 and start a terminal session.
A screen similar to the following will appear during the boot process:
Figure 5-3: HyperTerminal System Boot screen

2.

When the boot process has completed, type bootChange and press Enter to configure
the unit. This command is case-sensitive.
A list of boot parameters appears one line at a time. When configuring the Main
Processor, the screen will look similar to this:
Figure 5-4: Main Processor boot parameters

When configuring a Transient Processor, the screen will look similar to this (note the
difference in the file name value, which includes a "t" for Transient, and the different
boot flags:
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Figure 5-5: Transient Processor boot parameters

Note
Only change boot flags under the direction of Emerson Product Support.

If allowed to complete without interruption, the boot process should finish with a screen
similar to this:
Figure 5-6: HyperTerminal Boot Complete screen

5.7.1

HyperTerminal navigation after boot complete
After typing bootChange in a HyperTerminal session, use the following commands to
navigate:
Note
When modifying an entry, type the new setting. Do not attempt to backspace over an existing entry.
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Table 5-4: HyperTerminal navigation commands

5.7.2

Key sequence

Description

Enter

Accept the value.

. (period)

Clear the value when you press the period key followed by Enter.

– (dash)

Go back to the previous parameter when you press dash followed
by Enter.

Ctrl + B

Toggle between Main Processor and Transient Processor.

Ctrl + T

Display/hide label that identifies the processor producing output to
the screen.

reboot (case sensitive)

Reboot the board with new boot settings.

HyperTerminal navigation after boot interrupt
You may interrupt the boot process by immediately pressing Space after the VxWorks
copyright is displayed. If you interrupt the boot process, use the following commands to
navigate the boot configuration console.
The most commonly used commands are ?, @, P, and C.
Note
When modifying an entry, type the new setting. Do not attempt to backspace over an existing entry.

CAUTION!
Use only the first four commands (?, @, P, C) in Table 5-5. Contact Emerson Product Support
before using the other commands.

Table 5-5: Boot interrupt navigation commands
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Command

Description

?

Print this list

@

Continue boot (load and go)

P

Print boot parameters

C

Change boot parameters

g adrs

Go to adrs

d adrs[,n]

Display memory

z adrs

Modify memory

f adrs, nbytes, value

Fill memory

t adrs, adrs, nbytes

Copy memory

e

Print fatal exception

n netif

Network interface device address and other important information
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5.7.3

Configure access to a CSI Machinery Health Monitor
from a computer
Use a terminal emulator such as Telnet or HyperTerminal to connect to the CSI Machinery
Health Monitor using a serial cable or an ethernet cable.(1) Configure the settings in
Table 5-6 in the terminal emulator's connection settings.
Prerequisites
You need a username and password to log on to a CSI Machinery Health Monitor with
Telnet.
Table 5-6: Serial connection setup

5.7.4

Setting

Value

serial port

COM1

baud rate

9600

data bits

8

stop bit

1

parity

none

flow control

none

Boot parameters
Table 5-7: Boot parameters
Boot parameter

Description

boot device

The device name of the system.
• shend0 (CSI 6500 and DCMII systems)
• cs (DCMI systems)

processor number

0

host name

The username for the FTP user.

file name

The path and filename of the firmware installed in the FTP site root
directory (C:\inetpub\ftproot, by default).
bin/6500 is the firmware for a CSI 6500.
bin/6500T is the firmware for a CSI 6500T.

inet on ethernet (e)

IP Address and Subnet in Hex:
192.168.0.10:ffffff00

inet on backplane (b)

Intentionally blank.

host inet (h)

The IP address of the FTP server.
Example: 192.168.0.1

(1) Telnet and HyperTerminal are Windows Features that are available but are not enabled by default. You can use other terminal emulator
programs.
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Table 5-7: Boot parameters (continued)
Boot parameter

Description

gateway inet (g)

The IP address of the gateway.

user (u)

The username for the FTP account.
If the field is set to anonymous the system issues commands with no user.
The FTP Server must be set up to allow connections from anonymous
users.

ftp password (pw)

The password for the FTP user.
If the field is set to anonymous the system issues commands with no user.
The FTP Server must be set up to allow connections from anonymous
users.
Boot flags.

flags (f)

Refer to Section 5.7.5 for a description of boot flag values. Add the boot
parameters together to specify more than one boot parameter.

5.7.5

target name (tn)

(Optional) When you connect to an online system using a terminal
session, the prompt (>) will be preceded by the target name, if set. If
you have several terminal sessions open to different online systems,
specify a unique target name on each unit to help you identify them.

startup script (s)

Intentionally blank. Contact Technical Support for information on using
a startup script.

other (o)

(CSI 6500T only) IP Address of WINS server, if configured.

Boot flags
Notes
•

•

This table covers DCMII, DCMIII, and Transient units.
-

DCMIII units include the CSI 6500 and CSI 6500T.

-

DCMII units include the CSI 4500 and CSI 4500T with blue faceplate (with or without
display screens).

Boot flags below are expressed in hexadecimal. To activate more than one boot flag at the
same time, add them together using the Windows Calculator. Select View > Programmer, and fill
the circle for Hex math.

Table 5-8: Complete list of boot flags
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Boot Flag

Description

0x0001

Skip SDRAM testing on cold boot (for testing).

0x0002

Load local system symbols (for debug).

0x0004

Don't autoboot (for testing).

0x0008

Quick autoboot (no countdown).

0x0010

Disable input from shell.

0x0020

Disable login security.
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Table 5-8: Complete list of boot flags (continued)

5.7.6

Boot Flag

Description

0x0040

Use BOOTP to get boot parameters (network boot only).

0x0080

Use TFTP to get boot image (network boot only).

0x0100

Use Proxy ARP (network boot only).

0x0200

Ignore BOOTROM update image in FLASH (for testing).

0X0400

Change Ethernet speed from 100 Mbps to 10 Mbps (Main Processor only).

0x0400

Redirect the console I/O to COM1 (Transient only).

0x0800

Disable boot file update in FLASH (for development).

0x0800

Boot over a WAN, requiring extended FTP timeouts. This flag applies only if one of
three flags is set: 0x1000, 0x2000, 0x4000.

0x1000

Attempt network, fallback on FLASH boot (legacy 4500 mode).

0x2000

Boot ALWAYS from network, never fallback on FLASH.

0x4000

Boot ONCE from network. This flag clears itself after one boot.

Subnet masks
A subnet mask is normally represented in Windows as a series of four decimal numbers,
each of which can have a value from 0 to 255, separated by periods (255.255.248.0).
In the 6560 Processor module, the subnet mask is represented as a series of four
hexadecimal pairs with no separators (that is, 255.255.248.0 is represented as fffff800). A
hexadecimal conversion table can be used to convert the subnet mask numbers from
decimal to hexadecimal. The calculator in the Windows Accessories folder will also
perform this conversion when it is set to Programmer Mode.

5.7.7

Specify a subnet mask
The subnet mask on a 6560 Processor module defaults to 255.255.255.0 (ffffff00).
Procedure
1.

The subnet mask should be set to match the subnet mask used on the server PC.
If they do not match, network communication failure is possible.

2.

MHM-97453, Rev 1

On the configuration labeled inet on ethernet, enter the IP address of the unit followed
by a colon and then the subnet mask in the hexadecimal format.
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5.8

Add an Online Server to RBM Network
Administration
After you install AMS Machinery Manager Online Server, add the Online Server in RBM
Network Administration.
Prerequisites
Install and set up an AMS Machinery Manager Online Server.
Procedure
1.

In RBM Network Administration, select Online Server > Add Online Server.
The Add Online Server dialog appears.

2.

Click Browse.

3.

In the Browse for Computer dialog, select a computer where AMS Machinery
Manager Online Server has been installed and click OK.
The computer name appears in the Add Online Server dialog.
Note
You can type the computer name in Online Server Name instead of browsing.

4.

Click OK.
The computer name appears in the Online Server pane.

5.8.1

Add a unit's IP address to the Online Server in RBM
Network Administration
Prerequisites
Add an online server in RBM Network Administration.
The unit must have an IP address in the same network as that of the online server.
Procedure
1.

In RBM Network Administration, select Online Server > Online Server Setup.
The Online Server Setup window appears.

2.

Select a server name from the Online Server menu.
The Online Server box displays the AMS Machinery Manager database assigned to the
selected Online Server. Active Units lists the CSI Machinery Health Monitors
monitored by the selected Online Server.

3.
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If data is being collected, click Stop Data Collection.
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Data collection must be stopped to make changes.
The Edit buttons become active.
4.

Click Edit beside the Active Units box.
A New Unit field appears.

5.

Type in the IP address in New Unit and click Add New.
The unit appears in the Active Units list.

MHM-97453, Rev 1

59

Software configuration

60

MHM-97453, Rev 1

Data collection and analysis

6

Data collection and analysis
Topics covered in this chapter:
•
•
•
•
•
•
•
•
•
•

6.1

View or edit IP addresses with the unit
Verify or assign IP addresses to the database
Database configuration: overview
Online Watch overview
Archive management
Create archives manually
Disable archive predicates
Stop transient acquisition
Remove an archive from the Transient Archive Status tab
Change databases when moving the unit to a new machine

View or edit IP addresses with the unit
Verify the network addresses of the computer, the unit, and the database.
Procedure
1.

Start a terminal session on the CSI Machinery Health Monitor.
If you use a serial connection with PuTTy or HyperTerminal, you do not need a
username and password.
If you use a Telnet connection, log in with the following credentials. Both are casesensitive:
• username:csi
• password: csiSupport

2.

At the prompt, type bootChange and press Enter. This command is case-sensitive.
A list of boot parameters appears one line at a time.

3.

Press Enter to advance down the list of parameters.

4.

Note the IP addresses in the following fields:
The value in inet on ethernet is the IP address of the CSI 2600's Main Processor or
Transient Processor.
The value in host inet is the IP address of the computer where the FTP server is
installed.

5.
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On your computer, view the IP address of the FTP server by following Windows'
instructions for viewing IP addresses. Verify that this address matches the one
shown in host inet.
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6.2

Verify or assign IP addresses to the database
The online database must be configured with the IP addresses of assigned monitoring
units.
Procedure
1.

Log in to AMS Machinery Manager and click on RBM Network Administration.

2.

In the RBMadmin window, double-click the server listed under the Online Server
panel.

3.

In the Online Server Setup window, the Active Units panel lists the IP addresses of
units available for the online server.
If the system is configured to store data in a database, a database will be displayed in
the Machinery Health Manager Database frame, the two Edit buttons will be inactive,
and the Stop Data Collection button will be inactive.

4.

If necessary, assign the IP address of a CSI 2600 to Active Units.
a. In the Online Server Setup window, click Stop Data Collection.
b. Beside the Active Units panel, click Edit.
c. In the Edit Online Server's Active Unit List window, type the IP address of a new
CSI 2600 in the New Unit field.
d. Click Add New.
The IP address appears in the Active Units panel.
e. Click OK.
The Edit Online Server's Active Unit List window will close.
f. In the Online Server Setup window, click Start Data Collection.

Once a CSI 2600 IP address is listed in RBM Network Administration, that address may be
used for any existing or future database built with the online server. This task does not
need to be performed each time a new database is built.

6.3

Database configuration: overview
Configuring a database is different for a CSI 2600 than for other online monitoring
applications. In most cases, the CSI 2600 is not connected directly to sensors. Rather, it is
connected through coax cable with BNC connectors to a panel of monitoring modules.
These modules are connected to field wiring. Therefore, when building a database, it is
important to have a diagram that shows what sensors are connected to which monitoring
modules. In addition, an analyst who builds a CSI 2600 database needs to know if the
monitoring modules perform any signal conditioning on the input signals before passing
them through to their output connectors.
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The CSI 2600 has the capability to provide bias voltage and current (+24 V / 4 mA) for
accelerometers and must be in this configuration if connecting directly to accelerometers.
However, if connecting to a module, it is likely that the module powers/biases the
accelerometers and sensor power should not be turned on at each CSI 2600 signal
connection.

6.3.1

Database configuration pre-requisites
Have the following information available before you begin to build a database:

6.3.2

•

Sensors connected to each CSI 2600 signal channel; sensitivity, offset (eddy current
sensors, thrust probes), signal range.

•

Source of sensor power for accelerometers.

•

Definition of the transient event (speed drops below 3585 RPM, input relay from
external control system changes state, etc.)

•

Sensors for which transient measurements are desired.

•

IP address of a CSI 2600.

•

Bearing clearances (radial eddy current sensors).

•

Resting DC voltage measurements for radially mounted eddy current sensors.

Collection predicates
Predicates are conditions that have a value of True or False, and are used to guide
measurement operations.
A Collection Predicate tells the system when to perform a routine data collection based
upon the definition created in the database. Inputs into this type of predicate include:
•

speed

•

Gross Scan AC amplitude

•

Gross Scan DC amplitude

•

discreet input signal

•

another predicate

An example of a Collection Predicate for a CSI 2600 transient operation would be "Speed
below 3585 RPM". This predicate will have a value of False if speed is above 3585 RPM. It
would have a value of True if speed is below 3585 RPM.

6.3.3

Configure a collection predicate
Use Online Configuration to create a collection predicate.
Procedure
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1.

In the tree structure in the left panel, expand Units, expand the CSI 2600 that will
collect data, right-click the Predicates folder, and select Add Collection Predicate.

2.

Enter a name for the predicate. Do not include spaces.
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3.

Click the Tach drop-down menu and select the tachometer to be used for
acquisition.
This will be a tachometer connected to CSI 2600 tach location 1, 2, 3, or 4.
The Tach Clause dialog opens.

6.3.4

4.

Click the Comparison drop-down menu and select an equation for the predicate.

5.

Enter an RPM value in the Speed1 field.

6.

Click OK.

7.

Click Apply to finish.

Configure a database for transient operation
The CSI 2600 system may be used to simultaneously monitor machinery under normal
operating conditions and to create a large archive of information for those signals
designated (while building the database) as transient. All sensor connections to the CSI
2600 are configured for predictive operation. Some (or all) of these are also designated as
transient and are configured for transient operation.
Procedure
1.

Create collection predicate for transient auto-archive operation.
When you create an auto-archive definition, this collection predicate will cause the
CSI 2600 to automatically transfer an archive of transient measurements to the
online server, where they can be viewed by an analyst. Archives stored on the
transient hard drive will eventually be written over by new measurements.

2.

Configure the Measurement Points to associate tach channels with vibration
channels.
a. In Online Configuration, right-click Areas, select Add Area.
b. Enter an Abbreviation and Description, and click Apply.
c. Right-click the newly created Area and select Add Equipment.
d. Enter an Abbreviation and Description, and click Apply.
e. Right-click the newly created Equipment and select Add Component.
f. Enter an Abbreviation and Description, and click Apply.
g. Right-click the newly created Component and select Add Measurement Pt.
h. Enter an Abbreviation and Description, and click Apply.
i. With Component Properties still open, click the Monitoring Unit tab.
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Figure 6-1: Online Configuration—Component Properties

j. In the CSI Online Monitoring Unit field, click Attach.
k. Select the unit and click Okay.
l. In the Component Properties field, click Apply.
3.

Commission transient channels.
Transient channels may be commissioned all at once, unlike prediction channels. An
analyst may designate some or all of the already commissioned predictive channels
for transient operation. Some signals, such as case expansion may not include
valuable transient information. In this case, they do not need to be commissioned as
transient—only as predictive signals.
a. In the Online Configuration tree structure, right-click on the unit and select
Commission Transient Channels.
The Commission Transient Channels dialog appears, showing signals already
commissioned for predictive operation.
b. Select the desired tach channel, and click the check box for each signal input you
want to associate with the tach channel.
c. Click the Acquire button.
Measurements for the entire set of signals are shown.
d. Click Commission to commission the channels for transient operation.
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Data collection starts when you save the configuration to the O_server, which
also downloads it to the unit.
4.

Create an Auto-Archive definition.
This tells the CSI 2600 when to automatically send an archive of measurements to
the online server.
a. Right-click the Transient Tachometer and select Transient Auto-Archive Properties.
The Auto-Archive Properties dialog appears.
b. Set the Pre-trigger time (in minutes) and Post-trigger time (in minutes).
Pre-trigger time indicates how long the auto-archive will take measurements
before the collection predicate changes to TRUE. Post-trigger time indicates how
long the auto-archive will take measurements after the collection predicate
changes to TRUE.
After all measurements have been collected, the archive will be sent from the CSI
2600 to the online server.

6.3.5

Review and save a transient database
After creating a database, create a report to review your database configuration. The
report includes:
•

firmware revision used by the unit

•

calibration information for the unit

•

predicates and their definitions

•

signal connections, transient or predictive

•

tachometer definitions

•

relay definitions

Procedure
1.

In the Online Configuration tree structure, right-click on the unit and select Report.

2.

Select File > Online Server > Save.
The database configuration is downloaded to the unit.

6.4

Online Watch overview
AMS Machinery Manager Online Watch monitors system status and views the latest
measurements.
To open Online Watch, log in to AMS Machinery Manager, click the Tools tab, and in the left
panel, click Analysis.
Online Watch can perform four specific transient operations:
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•

Create archives manually.

•

Disable archive predicates.

•

Stop transient streaming to the CSI 2600.

•

Remove archives from the Transient Archive Status tab.

Transient system status includes:
•

Streaming/not streaming to HDD

•

Time of oldest recorded information

•

Progress of archive creation

The Online Watch screen displays CSI 2600 status, and the status of any archives. This
display has two tabs, Transient Status and Transient Archive Status.
Transient archives are stored under the server folder …\CustData. Two items will be created
in this folder. One is the actual CSI 2600 database file, with an .rbm extension. The other is a
sub-folder with the same name as the CSI 2600 database. Inside this sub-folder is a
collection of other folders, including one named archives. Transient archives are stored
under this archives folder, with a separate folder for each archive.

6.4.1

Online Watch—Transient Status tab
Figure 6-2: Online Watch—Transient Status
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Table 6-1: Transient Status tab fields
Field

Message

Description

Status

Node(Unit)Up

Unit is ready to monitor using the database definition.

Acknowledged

Unit is reorganizing internal software and schedules to conform to the
database definition.

Current
Acquisition
State

Transient Acquisition has
started

Transient measurement is proceeding normally.

Transient Acquisition has
stopped

Transient measurement was manually stopped.

Unknown

Temporary message after a database is downloaded.

Active
Streaming
Location(1)

Primary

Transient system is recording to the primary drive, as specified in Online
Configuration > Unit Properties.

Failover

Transient system has detected a problem with the primary drive and is
recording to a Failover drive, as specified in Online Configuration > Unit
Properties.

Transient
Drive Details

Oldest Data

Date and time of the oldest measurements currently stored in the unit.
Update this field by clicking Refresh.

Newest Data

Date and time of the newest measurements currently stored in the unit.
Update this field by clicking Refresh.

Storage
Primary
Location
Configuration

Path displays which drive—Internal, External, No Path—has been specified
as the primary streaming location. Size displays how much memory is
available.

Failover

Path displays which drive—Internal, External, No Path—has been specified
as the secondary streaming location. Size displays how much memory is
available.

Tach #

Tachometer input associated with a group of transient vibration
channels.

Speed

Current speed measured by the Tach input.

Predicate

Name of the predicate used for triggering the auto-archive .

Last Report

Date and time of the most recent archive.

State

True means the parameters of the auto-archive predicate are being met
and data is being recorded to the drive. An analyst can select the
Transient Archive Status tab to monitor the progress of archive creation.

Auto-Archive
Status

False means the parameters of the auto-archive predicate are not being
met and data is not being recorded.
Disabled means the automatic archive predicate has been disabled.
(1) The Active Streaming Location is where transient data is recorded during normal/constant CSI 2600 operation. Measurements from
this drive are extracted when an archive is created, and sent as a folder (archive to the online server).

6.4.2

Online Watch—Transient Archive Status tab
The Transient Archive Status tab shows archives that are currently being created.
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Figure 6-3: Online Watch—Transient Archive Status

Table 6-2: Transient Archive Status fields
Field

Message

Description

Component

(variable)

Displays the machine component associated with the transient archive
group.

Archive Name

(variable)

Displays the name of the archive that was specified in Online
Configuration.
Range 1500_2985 indicates that the collection predicate is TRUE for
speeds between 1500 and 2985 RPM.
The number in _0__ is reserved to ensure the filename is always unique.
05-30-2007 indicates the date the archive was created, in mm-dd-yyy
format.
10.17.07 indicates the time the archive was created, in hh.mm.ss format.

Archive Status

Archive Type
Percent
Complete

Pending

The system is waiting for post-trigger data to be collected, before
sending that data to the database.

Archiving

The system is sending a complete set of measurements to the online
server.

Complete

All measurements have been sent to the online server.

Predicate + parameters

The archive was initiated by a predicate.

Manual

The archive was initiated on-demand by a user.

00.00%–100.00%

Displays progress while the system sends measurements to the online
server.

6.5

Archive management
Archives are stored in folders in C:\RBMnet\RBMsuite\CustData\.
Computers have a finite amount of video display memory that may limit the amount of
graphic data viewed in an archive. To achieve efficient CSI 2600 system operation, an
analyst should regularly review extracted archives and keep only those of interest or only
the portions of interest in each archive. An analyst can extract smaller archives from large
ones using the program Vibration Analysis. To extract and view large amounts of
information from the CSI 2600, an analyst should sequentially extract individual archives of
1 - 2 hours of measurements.
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6.6

Create archives manually
There are three major differences between manually created archives and automatically
created archives:
•

Manual archives only include information already in the CSI 2600. Automaticallygenerated archives can include information which is received after the transient
collection predicate = TRUE.

•

Manual archives do not automatically have a date-time stamp appended to them.
Ensure that unique names are assigned.

•

Manual archives may have more than one hour of measurements in them.
Automatically generated archives have a maximum of 60 minutes of
measurements.

Procedure
1.

In Online Watch, select a component that has transient signals.

2.

Right-click and select Start Transient Archive.

3.

Define the manual archive characteristics.

Postrequisites
Observe the progress of manual archives in the Transient Archive Status tab.

6.7

Disable archive predicates
An analyst can disable the creation of automatic archives during startup or when the
machine is being cycled and multiple archives are not desired.
Procedure
1.

In the Transient Status tab, right-click on the archive predicate and select Disable
Archive Predicate.
A caution window appears.

2.

Click Okay to confirm disabling.

The predicate State on the Transient Status tab reads Disabled.
To re-enable the archive, right-click on the archive predicate and select Enable Archive
Predicate.
Example: Archive creation
When an archive predicate changes from DISABLED to TRUE, no archive is created.
Consider the following sequence:
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1.

Archive predicate is false.

2.

Archive predicate is disabled prior to machinery start-up.
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3.

Machine starts up and increases to a speed of 1800 RPM.

4.

Archive predicate is re-enabled.

5.

Archive predicate immediately changes to value of TRUE.

6.

No archive is created.

7.

Machine speed continues to rise and reaches a speed of 3000 RPM.

8.

Archive predicate changes to value of FALSE.

9.

Machine trips and speed drops below 2985 RPM.

10.

Archive predicate changes to value of TRUE.

11.

Archive is automatically created and sent to online server.

Disabling or re-enabling archive predicates only determine whether or not the CSI 2600
will send an archive to the online server. This does not stop the CSI 2600 from recording
measurements. In the above sequence, an analyst could extract a manual archive starting
at the time when the archive predicate was initially false and ending at the time that the
machine was at 3000 RPM.

6.8

Stop transient acquisition
An analyst can command the CSI 2600 to stop recording transient data.
Procedure
1.

In the Online Watch tree structure, right-click on the CSI 2600 and select Stop
Transient Acquisition.
A caution window appears.

2.

Click Okay to confirm.

In the Transient Status tab, Current Acquisition State displays the message Transient
Acquisition has stopped, and the CSI 2600 is no longer streaming data to the designated drive.

6.9

Remove an archive from the Transient Archive
Status tab
In the Transient Archive Status tab, right-click on the archive and select Acknowledge
Transient Archive.
Note
Removing archives does not delete archives from the online server; it only removes them from the
list in the Transient Archive Status tab.

MHM-97453, Rev 1

71

Data collection and analysis

6.10

Change databases when moving the unit to a
new machine
Because the CSI 2600 is a portable system, analysts must ensure that measurements from
one machine are not stored in a database or archive folder for a different one.

CAUTION!
Ensure that the following sequence is observed whenever moving the CSI 2600 from one
monitoring rack or machine to another. Data from one machine could be stored in the
database of another machine if this sequence is performed incorrectly.

CAUTION!
Changing databases will reinitialize the Transient HDD, which eliminates all stored data.
Extract any data before changing databases.

Prerequisites
Before disconnecting from the first machine, log in to AMS Machinery Manager.
From the Tools tab, click Setup/Communication and open RBM Network Administration.
Procedure
1.

In the bottom center panel labeled Online Servers, double-click the server.
The Online Server Setup dialog opens.

2.

Click Stop Data Collection.

3.

Disconnect the unit from the first machine.

4.

Connect the unit to the second machine.

5.

In Online Server Setup, click the Edit button next to Machinery Health Manager
Database—not next to Active Units.

6.

Select the second machine's database when prompted.

7.

In Online Server Setup, click Start Data Collection.

The system will now store any measurements or archives in the second database.
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Appendix A
Specifications
Topics covered in this appendix:
•
•

A.1

CSI 2600 product specifications
Module specifications

CSI 2600 product specifications
The CSI 2600 Machinery Health Expert comes in a case with a retractable handle and two
wheels for roll around transport.
Table A-1: Physical dimensions—case
Height

13.75 in.

Width

19.5 in.

Depth

24.5 in.

Weight (with case and unit)

53 lb.

Table A-2: Physical dimensions—unit
Height

20.5 in.

Width

8.25 in.

Depth

16 in.

Weight (unit alone)

30 lb.

Table A-3: Operational conditions
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Relative humidity

Temperature range

0–95% R.H. non-condensing

-17–55°C

0–50% R.H. non-condensing

-17–65°C
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A.2

Module specifications

A.2.1

6560 Processor module
6560 Processor module specifications at 25°C

Table A-4: 6560 Processor module specifications at 25°C
Memory Capacity

32 MB SDRAM, 32 MB Flash

Network Communication

10/100Base-T Ethernet dual RJ45 jacks wired for NIC and HUB, with two additional
jacks on backplane

Local Communication

RS232 (up to 38.4 Kbs)

Onboard Test Generator

All sensor channels, tachometer channels, AC, DC amplitude, phase (0 V - 3 V pk,
0.25 Hz - 50 kHz sine +/- 7.2 VDC, GND +/- 1 mV)

Rack Health Relay

SPDT 24

Sensor Channel Scan

RMS + DC, rate equivalent to16 ch per 500 ms

Overall Vibration Units

RMS, RMS or peak-to-peak with Transient Option

DC Scan

Simultaneously scanned with overall vibration scan (includes DC Gap,
temperature, and accelerometer bias)

Gross Scan and DC Accuracy

1% at input channel range full scale amplitude @ 1 kHz

Gross Scan ADC Resolution

16 bit

Data Acquisition Event Basis

Relay input, RPM, DC, AC or software controlled

Data Collection

Event-based adaptive

Data Collection Interval

Event-based and/or time-based

Data Storage Interval

Exception-based and/or time-based

Spectral ADC Resolution

24 bit, 2 channel simultaneous

Dynamic Range

100 dB, all frequency ranges

Spectral Resolution

100 to 6400 lines

Analysis Bandwidth

10 Hz to 40 kHz, discrete steps

Spectral Scan Rate

Depends on analysis configuration (1 second per two channels @ 400 lines, 400 Hz
1 avg)

Spectral Amplitude Accuracy

5% 0.2 Hz - 0.5 Hz 2% 0.5 Hz - 25 kHz 4% 25 kHz - 40 kHz

Frequency Accuracy

0.01%, crystal based

Total Harmonic Distortion

<-90 dB, all ranges

1X Synchronous Peak Accuracy

3% 0.5 Hz - 3 Hz 2% 3 Hz - 1 kHz 5% 1 kHz - 5 kHz

1X Synchronous Phase Accuracy

4 0 1 Hz - 1 kHz (not calibrated below 1 Hz) 5 0 >1 kHz

Analysis and Trend Types

Configurable, with user-defined parameter names, multiple analysis types per
machine and per sensor. (Total Energy, Energy in a range. Non-sync energy in a
range, Sync energy in a range, Sync peak, Sync phase, True peak, HFD, Waveform
peak-to-peak, RPM, Gap, Orbit)
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Table A-4: 6560 Processor module specifications at 25°C (continued)
Averaging Types

Normal, PeakVue, Order Tracking, Synchronous Time Averaging

Units Types

English, Metric, HZ, CPM, Order

Scaling Types

Linear, Log, dB

Windows Types

Hanning, Uniform

Processor module LEDs
The 6560 Processor module has seven two-color LEDs. From top to bottom these are:
Input Power, CPU Status, Transient Status, System Status, Server Connect, Modbus
Connect, and Hard Drive Active.
Figure A-1: 6560 Processor module LEDs
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Input Power LED
The Input Power LED indicates the status of the power converters that distribute various
voltages within the 6560 Processor module. A steady green color indicates that all power
converters are within the proper voltage ranges, while a steady or blinking red condition
indicates a power fault somewhere inside the 6560 Processor module.

CPU Status LED
The CPU Status LED indicates the status of the Main Processor board. The four status
conditions are listed in Table A-5 along with their assigned priorities.
More than one status condition may be active at one time. When this happens, the LED will
indicate the active status condition with the highest priority. For example, if the module is
both Uncalibrated (Priority 3) and is also currently In POST (Priority 1), the LED would indicate
In POST.
Table A-5: CPU status conditions
LED Color

Status

Priority Comments

Blinking Green

In POST

1

Typically only seen during system startup. Indicates
that POST (Power On Self Test) is being performed,
which involves Processor board resources.

Solid Red

Failure

2

Power supply POST failure, or other hardware
failure on processor board.

Alternating Red/
Green

Uncalibrated

3

The onboard Test Function generator is
uncalibrated.

Solid Green

OK

4

Normal operation.

Transient Status LED
The Transient Status LED indicates the status of the Transient Daughterboard. The LED is
always off when a Transient board is not installed in the system. The four status conditions
are listed in Table A-6 with their assigned priorities.
More than one status condition may be active at one time. When this happens, the LED will
indicate the active status condition with the highest priority.
Table A-6: Transient Daughterboard status conditions
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LED Color

Status

Priority Comments

Blinking Green

In POST

1

Typically only seen during system startup. Indicates
that POST (Power On Self Test) is being performed,
which involves Processor board resources.

Solid Red

Failure

2

Power supply POST failure, or other hardware
failure on processor board.

Alternating Red/
Green

Uncalibrated

3

One or more Transient channels are uncalibrated.
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Table A-6: Transient Daughterboard status conditions (continued)
LED Color

Status

Priority Comments

Solid Green

OK

4

Normal operation.

System Status LED
The System Status LED indicates the status of the overall system. It indicates the active
status condition with the highest priority of all boards in the system. For example, if the
Test Function generator on the Main Processor board is uncalibrated and the first MSIG
module has a power fault, the LED will show a solid red color to indicate the MSIG module
power fault, which is a “Failure” state.
When all the firmware components are operating as expected, this LED overlays a
“heartbeat” pulse pattern on top of the system status. The heartbeat pattern occurs in a
four-count cycle. The LED is pulsed off briefly during each of the first and second counts,
and then left on during the 3rd and 4th counts. In practice, it gives the appearance of a
human heartbeat. If the heartbeat stops, it indicates a firmware fault has occurred. Many
times the system is capable of recovering from a missed heartbeat. However, if the system
cannot recover quickly, it will automatically reboot itself to clear the fault and will then
resume monitoring.

Server Connect LED
The Server Connect LED indicates when Machinery Health Manager software or the DHM
diagnostic software are connected.
•

A green color indicates that at least one Machinery Health Manager software client
is connected or that the DHM software is connected in the client mode.

•

A red color indicates the DHM software is connected in the Single User mode. In this
state, no other clients can connect.

•

If the LED is off, it indicates that neither of these types of software clients are
connected.

There is no indication of client data transfer, only the presence of at least one established
connection.

Modbus Connect LED
The Modbus Connect LED indicates when a Modbus client, Web Browser, or Transient Live
client are connected.
•

A green color indicates that at least one of these types of clients has established a
connection.

•

If the LED is off, it indicates that none of these types of clients is connected.

The red color is not used with this LED.
There is no indication of client data transfer, only the presence of at least one established
connection.
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Hard Drive Active LED
The Hard Drive Active LED indicates when the onboard Transient hard drive is being
accessed with read/write activity.
The green LED blinks on each time a read or write activity accesses the Transient hard
drive. The more time the LED is green, the more hard drive activity.
This LED is always off if there is no Transient board installed in the system.
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A.2.2

6510 Signal Input module
Signal Input module specifications at 25°C

Table A-7: Signal Input module specifications at 25°C
Sensor Input Types

Dynamic displacement probe, Accelerometer, Velocity probe, AC input - custom
definable (for example, Flux, Dynamic pressure sensor, Dynamic basis weight input, etc.),
DC input - custom definable (for example, Temperature or other process input), 4-20 mA
Signal (with external shunt resistor).

Number of Sensor Inputs

16 inputs per module (12 sensor, 2 tach, 2 I/O, 2 modules per rack)

Analysis Bandwidth

0.2 Hz to 40 kHz (0.2 Hz to 2 kHz for Transient Analysis)

AC Coupling Corner
Frequency

0.5 Hz

RMS Conversion Accuracy

1% at full scale amplitude 30 Hz - 40 kHz 2.5% at full scale amplitude 20 Hz 5% at full scale
amplitude 10 Hz (uncalibrated below 10 Hz)

DC Accuracy

1% at full scale amplitude

Analog Integration

1 per channel (acceleration to velocity or velocity to displacement)

Analog Integrator Accuracy

2% (frequency and amplitude)

AC Input Range

Software configurable: + 5 V pk, + 10 V pk

DC Input Range

+ 22 VDC

Maximum AC + DC Input
Range

+ 22 V

Powered Sensor Types

ICP Accelerometer and velocity probes by each sensor channel, and displacement probes
by fused -24 VDC power supply on each channel

Sensor Power

4 mA (nominal) constant current, with 22 V compliance per current

Powered Channel Input
Impedance

500 kOhm (single ended)

Non-Powered Channel Input 1 MOhm (differential)
Impedance
Non-Powered Sensor Type

Displacement, AC or DC process

RMS to DC Converter

1 per channel, 1 Hz to 40 kHz

Number of Tachometer
Channels

2 inputs per module, 4 total per rack

Tachometer Frequency
Range

0.1 Hz to 2 kHz (6 RPM to 120,000 RPM)

Tachometer Frequency
Accuracy

0.1%

Tachometer Resolution

0.002 Hz @ 60 Hz (0.1 RPM)

Tachometer Types

Eddy current displacement probe, TTL, passive magnetic

Tachometer Amp. Range

Input and trigger pulse range + 0.5 V pk to + 22 V pk

Pulse Characteristics

1 pulse per revolution, 500 uS minimum pulse width, tach divider on module

MHM-97453, Rev 1

79

Specifications

Table A-7: Signal Input module specifications at 25°C (continued)
Modes

Volt compare, automatic adaptive, divide by N (N=1-1024)

Input Impedance

1 MOhm (differential)

Number of Digital I/O
Channels

2 per module (configurable as input or output), 4 total per rack

Relay Type

SPST 24 VDC @ 0.5 ADC dry contact

Digital Input Current Max.

10 mA @ 24 VDC

Digital Input High Voltage

5 VDC - 24 VDC

Digital Input Low Voltage

<3 VDC

Signal Input module LEDs
Every 6510 Signal Input module has two, two-color LEDs. The top LED indicates the power
converter status and the bottom LED indicates overall module status.
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Figure A-2: 6510 Signal Input module LEDs

Power LED
The Power LED indicates the status of the MSIG module power converters.
A steady green color indicates that all voltage levels are OK, while a steady or blinking red
condition indicates a power fault somewhere within the module.

Status LED
The Status LED indicates the overall status of the module. The four status conditions are
listed in Table A-8 along with their assigned priorities.
More than one status condition may be active at a time. When this happens, the LED will
indicate the active status condition with the highest priority.

MHM-97453, Rev 1

81

Specifications

If the Status LED is off, the Signal Input module is being ignored by the 6560 Processor
module. This is a special case which should not be encountered in practice. Modules are
only ignored if the addition of the module would exceed the maximum channel count
limits that the 6560 Processor module can support (24 analog, 4 Tach, 4 I/O). Channels are
counted starting in the left-most.
Table A-8: Signal Input Module status conditions
LED Color

Status

Priority Comments

Blinking Green

In POST

1

Typically only seen during system startup. Indicates
that POST (Power On Self Test) is being performed,
which involves Processor board resources.

Solid Red

Failure

2

Power supply POST failure, or other hardware
failure on processor board.

Alternating Red/
Green

Uncalibrated

3

One or more channels are uncalibrated.

Solid Green

OK

4

Normal operation.

Transient Filter Board specifications
Table A-9: Transient Filter Board specifications
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Number of channels

12

Filter type

8th order elliptic low pass

Filter passband frequency

DC to 2 kHz

Attenuation

80 dB

Passband ripple

<1 dB

Stop band frequency

3.12 kHz
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Appendix B
System calibration
The CSI 2600 uses internal calibration tables to compensate for slight measurement
variations that can occur across the temperature, voltage ranges, and variations in
individual electronic components used by processing circuitry. These calibration tables are
stored in each CSI 2600 when it is assembled and verified at the factory. The units apply
calibration corrections automatically during signal measurement and processing.
The CSI 2600 system calibration consists of two steps:
1.

Calibrate the on-board signal generator.

2.

Calibrate the system.

The Processor Module signal generator should be recalibrated at least once a year.
The CSI 2600 should be recalibrated at least once a year, or when the processor or a signal
input module has been replaced. To recalibrate an installed system, contact a local
Emerson Online Product Support office to schedule recalibration during an equipment
outage. Calibrations can be completed in less than an hour, but units cannot monitor
rotating equipment during that time.

B.1

The CSI 6560 Processor module
Four circuits are calibrated:
•

Test Signal Generator (TSG)

•

Gross Scan (GS)

•

Digital Signal Processor (DSP)

•

Transient

The TSG circuit is a key element. This circuit provides an extremely precise output signal,
which is used as an input during GS, DSP/Tachometer, and Transient calibrations
(Tachometer channels are calibrated during DSP calibration). During calibrations, the TSG
output is routed internally in the 6560 Processor Module, to processing electronics (GS,
DSP, Tach, Transient), and individual calibration tables for each processing circuit are
created and stored in 6560 Processor Module memory. These tables are stored in nonvolatile memory, which means that the tables are not erased if the 6560 Processor Module
is powered down.
The TSG circuit provides an output signal, which is used to create all of the other
calibration tables. The TSG circuit has its own calibration table, stored in the CPU board. If a
CPU board is replaced, then the other calibrations need to be rerun for that 6560 Processor
Module, since their original calibration tables used the TSG signal from the original CPU
board.
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Calibration tables may be copied from each 6560 Processor Module onto an online server,
and those can be downloaded into the same 6560 Processor Module. Emerson Online
Product Support personnel and Online Systems Engineers can assist customers with this
type of operation.
Calibration circuit inputs and outputs are shown in Section B.1.1

B.1.1

Calibration circuits input and output
Table B-1: Calibration circuits input and output

B.1.2

Calibration circuit

Input

Output

TSG (Test Signal Generator)

(external) signal

TSG table (internal) TSG signal

GS (Gross Scan)

TSG signal

GS table

DSP (Digital Signal Processor)

TSG signal

DSP table

Transient

TSG signal

Transient table

Test Signal Generator (TSG) calibration
All CPU boards provided by Emerson are shipped with a calibrated TSG circuit. If the CPU
board is purchased as part of a system, the entire system is calibrated using the CPU board
TSG circuit.
The TSG circuit is the only element that requires an external piece of test equipment and
special connection cables. TSG calibration requires:
•

Digital Multi Meter (such as the HP 34401A)

•

computer configured as online server

•

special calibration utility program (DHM)

•

cable that connects the computer to the 6560 Processor module Ethernet port

•

cable that connects the computer to the Digital Multi Meter

•

cable that connects the Digital Multi Meter to the test port on the unit

TSG calibration is unique in that it requires a separate test instrument, unique cables, and a
computer that is configured as an online server. It is recommended that qualified Emerson
Online Systems Engineers perform TSG calibration or recalibration.

B.1.3

Gross Scan (GS) calibration
GS calibration:
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•

uses a 6560 Processor module's TSG output signal.

•

does not require that any wire harnesses be disconnected.

•

is completed in about 10 minutes.

•

does not require any special cables or test equipment.
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•

uses a special calibration utility program (DHM).

GS recalibration should be performed:
•

annually.

•

whenever a 6510 Signal Input module is replaced.

•

whenever a 6560 Processor module is replaced.

•

if the calibration table has a status of "Unknown".

Product Support personnel can guide a plant engineer or technician through GS calibration
over the phone.

B.1.4

Digital Signal Processor (DSP) calibration
Digital Signal Processor (DSP) calibration:
•

uses a CPU board's TSG output signal.

•

does not require that any wire harnesses be disconnected.

•

is completed in about 30-40 minutes.

•

does not require any special cables or test equipment.

•

uses a special calibration utility program (DHM).

DSP recalibration should be performed:
•

annually.

•

whenever a 6510 Signal Input module is replaced.

•

whenever a 6560 Processor module is replaced.

•

if the calibration table has a status of “Unknown”.

Product Support personnel can guide a plant engineer or technician through DSP
calibration over the phone.

B.1.5

Transient calibration
The Transient unit includes two processing boards—a Main Processor board and a
Transient board. Both boards include separate Digital Signal Processors. The DSP on the
Transient board uses an internal calibration table, in much the same way that the Main
Processor DSP circuit does. However, it is calibrated separately, and not as part of a DSP
calibration for a Main Processor.
Transient calibration:
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•

uses a Processor module's TSG output signal.

•

does not require that any wire harnesses be disconnected.

•

is completed in about 30-40 minutes.

•

does not require any special cables or test equipment.

•

uses a special calibration utility program (DHM).
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Transient calibration should be performed:
•

annually.

•

whenever a 6510 Signal Input module is replaced.

•

whenever a Transient board is replaced.

•

whenever Main Processor board is replaced.

•

if the calibration table has a status of "Unknown".

Product Support personnel can guide a plant engineer or technician through Transient
calibration over the phone.
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Appendix C
Data types
Topics covered in this appendix:
•
•
•
•
•

C.1

Gross Scan analysis
Spectral analysis
Time Waveform analysis
Non-Vibration unit analysis types
Set DC offset

Gross Scan analysis
Includes Overall RMS Level, Sensor DC Bias, Gap, DC, or AC Process signals.
Note
Some DC Process Inputs could provide pk, pk-pk, or other Measurement Units.

Gross Scan parameters
All Gross Scan inputs must be DC in nature. Any Gross Scan input of a dynamic nature must
be fed through the RMS/DC converter path. It is not technically valid to convert RMS values
from an RMS/DC converter to pk or pk-pk Measurement Units unless the input is sinusoidal
in nature. However, the CSI 2600 allows this. RMS values are multiplied by 1.414 or 2.828
to convert from RMS to pk and pk-pk, respectively.

C.1.1

Gross Scan units conversion
Table C-1: Gross Scan units conversion
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Input
Type

Input Unit

HW Int.

RMS/DC

Meas. Unit

Disp. Unit

DC

V / E.U.

no

no

DC

E.U.

AC

V / E.U.

no

yes

RMS

E.U.

ACCEL

V / 32.2 ft/s

no

yes

RMS

g

V / 32.2 ft/s

yes

yes

RMS

in./s

V / 9.81 m/s

no

yes

RMS

g

V / 9.81 m/s

yes

yes

RMS

mm/s
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Table C-1: Gross Scan units conversion (continued)
Input
Type

Input Unit

HW Int.

RMS/DC

Meas. Unit

Disp. Unit

VEL

V / i/s

no

yes

RMS

i/s

V / i/s

yes

yes

RMS

mil

V / mm/s

no

yes

RMS

mm/s

V / mm/s

yes

yes

RMS

micron

V / mil

no

yes

RMS

mil

V / micron

no

yes

RMS

micron

DISP

C.2

Spectral analysis
Spectral analysis includes:
•

Total Energy

•

Energy within a Frequency Range

•

Synchronous Energy within a Frequency Range

•

Non-Synchronous Energy within a Frequency Range

•

HFD

•

Relative Synchronous Harmonics

•

Average

•

Synchronous Peak

Note
Total Energy, Energy within a Frequency Range, Synchronous Energy within a Frequency Range, NonSynchronous Energy within a Frequency Range, HFD, Relative Synchronous Harmonics, Average,
Synchronous Peak.RMS, pk, pk-pk Measurement Units are valid and can be freely converted.

Spectral Scan parameters
All Spectral Scan parameters must be AC in nature. It is possible to convert some analysis
type results between Measurement Unit types and Display Unit types.

C.2.1

Spectral units conversion
Table C-2: Spectral units conversion
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Input
Type

Input Unit

HW Int.

SW Int.

SW Diff.

Disp. Unit

AC

V / E.U.

no

no

no

E.U.
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Table C-2: Spectral units conversion (continued)
Input
Type

Input Unit

HW Int.

SW Int.

SW Diff.

Disp. Unit

ACCEL

V / 32.2 ft/s

no

no

no

g

V / 32.2 ft/s

no

single

no

in./s

V / 32.2 ft/s

no

double

no

mil

V / 32.2 ft/s

yes

no

no

i/s

V / 32.2 ft/s

yes

single

no

mil

V / 32.2 ft/s

yes

no

single

g

V / 9.81 m/s

no

no

no

g

V / 9.81 m/s

no

single

no

mm/s

V / 9.81 m/s

no

double

no

micron

V / 9.81 m/s

yes

no

no

mm/s

V / 9.81 m/s

yes

single

no

micron

V / 9.81 m/s

yes

no

single

g

V / i/s

no

yes

no

i/s

V / i/s

no

yes

no

mil

V / i/s

yes

yes

no

mil

V / i/s

no

yes

single

g

V / i/s

yes

no

single

i/s

V / mm/s

no

single

no

mm/s

V / mm/s

no

no

no

micron

V / mm/s

yes

no

no

micron

V / mm/s

no

no

single

g

V / mm/s

yes

single

mm/s

V / mil

no

no

no

mil

V / mil

no

no

single

i/s

V / mil

no

no

double

g

V / micron

no

no

no

micron

V / micron

no

no

single

mm/s

V / micron

no

no

double

g

VEL

DISP

C.3

Time Waveform analysis
Time Waveform analysis includes:
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•

Variance

•

True Peak

•

Waveform pk-pk
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Note
Measurement Unit type is specific to Analysis type. No Software Integration Differentiation can be
performed.

C.3.1

Time Waveform units conversion
Table C-3: Time Waveform units conversion
Input Type

Input Unit

HW Int.

Disp. Unit

AC

V / E.U.

no

E.U.

ACCEL

V / 32.2 ft/s

no

g

V / 32.2 ft/s

yes

in./s

V / 9.81 m/s

no

g

V / 9.81 m/s

yes

mm/s

V / i/s

no

i/s

V / i/s

yes

mil

V / mm/s

no

mm/s

V / mm/s

yes

micron

V / mil

no

mil

V / micron

no

micron

VEL

DISP

C.4

Non-Vibration unit analysis types
Non-Vibration unit analysis includes:
•

Peak to Average Ratio

•

Average to Minimum Ratio

•

Kurtosis

•

Skewness

•

Synchronous Phase

These analysis types produce non-unit ratios or specific unit types such as degrees of
phase. Measurement Unit Type will not apply to these parameters.

C.5

Set DC offset
For thrust probes, the input channel is defined as a DC Process input. Set the DC offset so
that the thrust reading may be zeroed.
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Procedure
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1.

Use a DC voltmeter (or the DHM program) to measure the DC voltage as seen
directly on the inputs.

2.

In Online Configuration, right-click on a unit and select Configure Unit.

3.

Right-click a channel icon and select Define.

4.

Set the Signal Type to Process.

5.

Select Properties and select the Sensor button.

6.

Highlight New and select OK to define a new sensor.

7.

Enter the voltage value into Offset Field.
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Appendix D
Internal wiring of the CSI 2600
Topics covered in this appendix:
•
•
•
•
•

D.1

Rear termination panel
Internal wiring diagram for the CSI 2600
Terminal descriptors
Rear terminal power connections
CSI 2600 DIP switch settings

Rear termination panel
The rear termination panel plugs directly onto the backplane. This termination panel has
connectors for sensor inputs, tachometer inputs, and discrete input/output relays into the
12-2-2 modules. All these connections are available through BNC connectors on the rear of
the CSI 2600.

Figure D-1: A6500-M-RTRM

Table D-1: A6500-M-RTRM
Termination panel
A

Sensor inputs: MSIG1 (Ch1–12)

B

Sensor inputs: MSIG2 (Ch13–24)

C

Tach inputs(1): MSIG1 (Ch1–2)

D

Tach inputs(1): MSIG2 (Ch 3–4)

E

Relay I/O(1): MSIG1 (I/O 1–2)

F

Relay I/O(1): MSIG2 (I/O 3–4)

G

DIP switches for routing buffered sensor/tach inputs from the A6500-P-RTRM side of the
rack

H

DIP switches for configuring sensor power On or Off(2)
(SW1, SW2, SW3, SW5, SW6, and SW7)

I

Calibration test signal output port
(SMB connector)

Table D-1: A6500-M-RTRM (continued)
Termination panel
J

-24 V sensor power input for eddy current sensors

(1) For Tach and Relay channels, leave the sensor power DIP switches in the OFF position.
(2) SW4 and SW8 correspond to tach and relay channels, and are not used.

Table D-2: A6500-M-BP backplane components
Backplane
K

SysFail relay connector

L

DC Power input connector for Prediction Side

M

HUB network connector

N

NIC network connector

O

Chassis Ground lug

P

Power On LED

Q

+24 V Input LED

R

Status LED

D.2

Internal wiring diagram for the CSI 2600

D.3

Terminal descriptors
Each channel has five terminals. The first two are for the plus (+) and minus (-) signal
inputs. If the associated DIP switch is set to ON, these terminals will also supply +24 V
constant current accelerometer power.
The second two are for the -24 V power supply for eddy current probes. These terminals
only supply power if an external -24 V power supply is connected to the J19 power input
terminal at the edge of the termination panel.
Note
For the CSI 2600, this connection is not used and the -24 V power is available on the panel-mounted
Phoenix connector on the rear of the case.

The last terminal for each channel is a chassis ground for connecting the sensor cable
shield.

Table D-3: Terminal descriptors for MSIG 1
J1

J2

J3

J4

SIG+1/+24V

SIG+5/+24V

SIG+9/+24V

Tach+1

SIG-1/+24V return

SIG-5/+24V return

SIG-9/+24V return

Tach-1

CH1 -24V

CH5 -24V

CH9

-24V

TACH1 -24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Chassis GND (Shield)

Chassis GND (Shield)

Chassis GND (Shield)

Chassis GND (Shield)

SIG+2/+24V

SIG+6/+24V

SIG+10/+24V

Tach+2

SIG-2/+24V return

SIG-6/+24V return

SIG-10/+24V return

Tach-2

CH2 -24V

CH6 -24V

CH10

-24V

TACH2 -24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Chassis GND (Shield)

Chassis GND (Shield)

Chassis GND (Shield)

Chassis GND (Shield)

SIG+3/+24V

SIG+7/+24V

SIG+11/+24V

I/O+1

SIG-3/+24V return

SIG-7/+24V return

SIG-11/+24V return

I/O-1

CH3 -24V

CH7 -24V

CH11

-24V

I/O1

-24V

Gnd (-24V return(1))

Gnd (-24V return(1))

Gnd (-24V return(1))

Gnd (-24V return(1))

Shield

Shield

Shield

Shield

SIG+4/+24V

SIG+8/+24V

SIG+12/+24V

I/O+2

SIG-4/+24V return

SIG-8/+24V return

SIG-12/+24V return

I/O-2

CH4 -24V

CH8 -24V

CH12

-24V

I/O2

-24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Chassis GND (Shield)

Chassis GND (Shield)

Chassis GND (Shield)

Chassis GND (Shield)

(1) -24 V terminals on I/O channels are not used for I/O connections.

Table D-4: Terminal descriptors for MSIG 2
J5

J6

J7

J8

SIG+13/+24V

SIG+17/+24V

SIG+21/+24V

Tach+3

SIG-13/+24V return

SIG-17/+24V return

SIG-21/+24V return

Tach-3

CH13 -24V

CH17 -24V

CH21 -24V

TACH3 -24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Shield

Shield

Shield

Shield

SIG+14/+24V

SIG+18/+24V

SIG+22/+24V

Tach+4

SIG-14/+24V return

SIG-18/+24V return

SIG-22/+24V return

Tach-4

CH14 -24V

CH18 -24V

CH22 -24V

TACH4 -24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Shield

Shield

Shield

Shield

SIG+15/+24V

SIG+19/+24V

SIG+23/+24V

I/O+3

SIG-15/+24V return

SIG-19/+24V return

SIG-23/+24V return

I/O-3

CH15 -24V

CH19 -24V

CH23 -24V

I/O3

-24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Shield

Shield

Shield

Shield

SIG+16/+24V

SIG+20/+24V

SIG+24/+24V

I/O+4

SIG-16/+24V return

SIG-20/+24V return

SIG-24/+24V return

I/O-4

CH16 -24V

CH20 -24V

CH24 -24V

I/O4

-24V

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Gnd (-24V return)

Shield

Shield

Shield

Shield

D.4

Rear terminal power connections
Figure D-2: Rear terminal power connections

D.5

CSI 2600 DIP switch settings
Each signal input channel has an associated DIP switch for connecting accelerometer
power. For accelerometer channels that require power from the CSI 2600, set the
associated DIP switch to the right, or On position. For sensor channels that do not require
power, set the associated DIP switch to the left or Off position.
Note
For the Tach and Relay channels, the DIP switches must be left in the Off position.

Troubleshooting

Appendix E
Troubleshooting
During the lifetime of a CSI 2600 system, an analyst may need to troubleshoot the following situations:

Table E-1: Troubleshooting
Issue

Solution/reference

FTP server IP address changed.

Update boot flag settings.

Measurements in Online Watch or
Vibration Analysis seem incorrect
or inconsistent.

If two instruments are showing different measurements for the same signal, it is
likely that:
• Different units are being used by the two instruments.
• The monitoring rack output signal is not an exact replica of the input signal,
rather it is a conditioned version.
• The monitoring rack output signal is a current-level signal (4-20 mA) not a
voltage signal.

Online Watch/ Online
Configuration shows status of
Node(Unit)Down.

The following are possible solutions:
1. Restart CsiO_Server service.
2. Verify that IP addresses set in boot parameters match those set in AMS
Machinery Manager.
3. With the unit connected to the network, ping the unit's IP address. If the ping
is successful, there is probably a configuration mismatch between the unit and
the server. Check the boot parameters. If the ping fails, there may be a
physical error (bad Ethernet connection, gateway between two units,
mismatching IP addresses).

System Status LED is red.

Establish a Telnet connection to check unit status. If there was a POST failure, a
flag will be set, and the title of the failure will be listed. Use these details to
diagnose the issue.

Automatic archive was not created. Predicate must change state from either FALSE or INDETERMINATE to TRUE.
Archive was truncated.

An archive will have a status of Truncated if an analyst extracts a block of data across
a gap in the time frame requested.

Unable to make changes to a
database.

The system is in the process of storing an archive created with an earlier database
configuration. Either wait for the archive to complete or cancel the archive.
The online server is attached to a different database. In RBM Network
Administration, change the database associated with the online server.
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accelerometer supplies 34, 35
active displacement sensor 31
actuator 42–44
adaptive automatic triggering 31
Alarm Limit Set 16
Analysis Parameter Set 16
anti-aliasing filter 33
auto-archive 16, 64, 67
Axial Thrust predicate 20

Measurement Point 17
MHM Remote 45
Modbus 3, 5, 6
Modbus Connect LED 77
Monitoring module 17
MtDbgMgr 45

B

N
NAS hard drive 13
Network Server 45
NIC port 19

BNC connectors 3, 5, 6, 20, 28, 62, 93

C
cautions 7
cleaning 6, 7
Collection Predicate 16
CPU Status LED 76

D
damage 6, 7
DAT recorder mode 12, 13
Data Collection Set (DCS) 17
DHM 84, 85
Digital Multi Meter 84
DIP switch 97

E
epoxy mount, sensors 38

H
Hard Disk Drive (HDD) 12
Hard Drive Active LED 78
hazardous area 7
Hub port 19
HyperTerminal 51

I
Input Power LED 76
Internet Information Services (IIS) 45, 48
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O
Object Linking and Embedding for Process Control
(OPC) 3, 5, 6
on-board signal generator 83
Online Configuration 45
Online Server 45
Online Watch 45

P
passive magnetic sensor 31
PeakVue 3, 5, 6
Phoenix connection 97
Power On Self Test (POST) 28, 76
precautions 6, 7
probe driver 44
PuTTY 51

Q
Quick-Connect base 39

R
Radial Trip predicate 20
Root Mean Square (RMS) 23, 25, 26, 30

S
sensors
accelerometer supplies 34, 35
epoxy mount 38
milling process, stud mount 35
mounting tools 34, 35
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stud mount 35
Server Connect LED 77
signal inputs
DC component 23
dynamic AC 23
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tachometer 23
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swivel mount 39
SysFail relay 25, 93
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Telnet 51
Transient Status LED 76
TTL pulse type sensor 31

V
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W
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